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Kurzübersicht

Für die schnelle und einfache Inbetriebnahme:

Integrierte Bedienungsanleitung

Das einfache Bedienkonzept des Gerätes erlaubt für viele Anwendungen eine Inbetriebnahme ohne 

gedruckter Betriebsanleitung. Ihr Gerät zeigt Bedienungshinweise auf Knopfdruck direkt am Bild-

schirm an! Trotzdem ist diese Anleitung im Lieferumfang des Gerätes enthalten - sie ist die Ergän-

zung zu den Bedienungshinweisen im Gerät. Hier wird erläutert, was nicht direkt durch Klartext 

oder Auswahllisten am Gerät beschrieben ist.

Abb. 1: Variable "Softkey" Taste (z.B. zum Aufruf der internen Hilfe-Funktion im Setup-Modus)

Diese Anleitung ist eine Kurzanleitung. Ausführliche Informationen entnehmen Sie der 

Betriebsanleitung und den zusätzlichen Anleitungen auf der mitgelieferten CD-ROM.

Diese Kurzanleitung ersetzt nicht die zum Lieferumfang gehörenden Betriebsanleitungen!

Die komplette Gerätedokumentation besteht aus:

• der vorliegenden Kurzanleitung

• einer CD-ROM mit PDF-Dateien der:

– Betriebsanleitung

– Grundlagen Messprinzip

– Zulassungs- und Sicherheitszertifikate

1. Beachten Sie die Sicherheitshinweise Seite 5



2. Montieren Sie das Gerät Seite 6



3. Verdrahten Sie das Gerät Seite 8



4. Installieren Sie die PC-Bediensoftware Seite 15



5. Verbinden Sie das Gerät mit dem PC Seite 15



6. Parametrieren Sie das Gerät (über PC) Seite 16



7. Übertragen Sie die Setupdaten auf das Gerät Seite 16
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1 Sicherheitshinweise

1.1 Bestimmungsgemäße Verwendung

Dieses Gerät ist für die elektronische Erfassung, Anzeige, Aufzeichnung, Auswertung, Fernübertra-

gung und Archivierung von analogen und digitalen Eingangssignalen in nicht explosionsgefährdeten 

Bereichen bestimmt.

• Das Gerät ist für den Einbau in eine Schalttafel oder einen Schaltschrank vorgesehen und darf nur 

im eingebauten Zustand betrieben werden.

• Für Schäden aus unsachgemäßen oder nicht bestimmungsgemäßen Gebrauch haftet der Herstel-

ler nicht. Wenn das Gerät unsachgemäß oder nicht bestimmungsgemäß eingesetzt wird, können 

Gefahren von ihm ausgehen.

1.2 Montage, Inbetriebnahme und Bedienung

• Das Gerät darf nur von qualifiziertem und autorisiertem Fachpersonal (z. B. Elektrofachkraft) 

unter strenger Beachtung dieser Anleitung, der einschlägigen Normen, der gesetzlichen Vor-

schriften und der Zertifikate (je nach Anwendung) eingebaut, angeschlossen, in Betrieb genom-

men und gewartet werden.

• Das Fachpersonal muss diese Anleitung gelesen und verstanden haben und die Anweisungen 

befolgen.

• Veränderungen und Reparaturen am Gerät dürfen nur vorgenommen werden, wenn dies in der 

Betriebsanleitung ausdrücklich erlaubt wird.

• Beschädigte Geräte, von denen eine Gefährdung ausgehen könnte, dürfen nicht in Betrieb 

genommen werden und sind als defekt zu kennzeichnen.

• Beachten Sie grundsätzlich die in Ihrem Land geltenden Vorschriften bezüglich Öffnen und Repa-

rieren von elektrischen Geräten.

1.3 Betriebssicherheit

• Das Gerät ist nach dem Stand der Technik betriebssicher gebaut und geprüft und hat das Werk 

in sicherheitstechnisch einwandfreiem Zustand verlassen. Die einschlägigen Vorschriften und 

europäischen Normen sind berücksichtigt.

• Beachten Sie die technischen Daten auf dem Typenschild! Das Typenschild befindet sich an der 

linken Gehäuseseite.

Störsicherheit

Die Messeinrichtung erfüllt die allgemeinen Sicherheitsanforderungen gemäß IEC 61010 und die 

EMV-Anforderungen gemäß IEC 61326.

Tischversion

# Warnung! 

• Der Netzstecker darf nur in eine Steckdose mit Schutzkontakt eingeführt werden.

• Die Schutzwirkung darf nicht durch eine Verlängerungsleitung ohne Schutzleiter aufgehoben 

werden.

• Relaisausgänge: U (max) = 30 V eff (AC) / 60 V (DC)

1.4 Sicherheitszeichen und -symbole

Achten Sie in dieser Betriebsanleitung konsequent auf Sicherheitshinweise, die mit den folgenden 

Symbolen gekennzeichnet sind:

# Warnung! 

Dieses Symbol deutet auf Aktivitäten oder Vorgänge hin, die - wenn sie nicht ordnungsgemäß 

durchgeführt werden - zu Verletzung von Personen, zu einem Sicherheitsrisiko oder zur Zerstörung 

des Gerätes führen können.
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" Achtung!

Dieses Symbol deutet auf Aktivitäten oder Vorgänge hin, die - wenn sie nicht ordnungsgemäß 

durchgeführt werden - zu fehlerhaftem Betrieb oder zu Zerstörung des Gerätes führen können.

! Hinweis! 

Dieses Symbol deutet auf Aktivitäten oder Vorgänge hin, die - wenn sie nicht ordnungsgemäß 

durchgeführt werden - einen indirekten Einfluss auf den Betrieb haben oder eine unvorhergesehene 

Gerätereaktion auslösen können.

ESD - Electrostatic discharge

Schützen Sie die Klemmen vor elektrostatischer Entladung. Ein Nichtbeachten kann zur Zerstörung 

von Teilen der Elektronik führen.

2 Identifizierung

2.1 Lieferumfang

• Gerät (mit Klemmen, entsprechend Ihrer Bestellung)

• 2 Schraub-Befestigungsspangen

• USB-Schnittstellenkabel, Länge 1,5 m (4.9 ft)

• Optional Secure Digital (SD) Karte (Karte nicht im Gerät, sondern liegt bei.)

• PC Bedien- und Parametriersoftware auf CD-ROM

• Lieferschein

• Mehrsprachige Kurzanleitung in Papierform

• Mehrsprachige Betriebsanleitungen auf CD-ROM

Fehlen Teile? Dann informieren Sie bitte Ihren Lieferanten!

3 Montage

3.1 Einbaubedingungen

Arbeitstemperaturbereich:

-10 bis 50 °C (22 bis 122 °F), max. 75% rel. Feuchte ohne Betauung.

" Achtung!

• Zur Vermeidung von Wärmestaus stellen Sie bitte stets ausreichende Kühlung des Gerätes sicher.

• Abstand zu starken magnetischen Feldern einhalten (vgl. Kap. 10 "Technische Daten", Störfestig-

keit)

• Zulässige Umgebungsbedingung frontseitig: gemäß Geräteschutzart max. IP65 (bei geschlossener 

Frontklappe)

3.2 Einbau

3.2.1 Montagewerkzeug

Zum Einbau in die Schalttafel ist lediglich ein Schraubendreher erforderlich.
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3.2.2 Schalttafeleinbau, Einbaumaße

Abb. 2: Schalttafeleinbau und Einbaumaße. Alle Angaben in mm bzw. (Inch)

• Einbautiefe ohne Klemmenabdeckung: ca. 158 mm (6,22") (inkl. Anschlussklemmen und Befes-

tigungsspangen)

• Einbautiefe mit Klemmenabdeckung: ca. 197 mm (7,76")

• Schalttafelausschnitt: 138+1 x 138+1 mm (5,43+0,04 x 5,43+0,04")

• Schalttafelstärke: 2 bis 40 mm (0,08 bis 1,58")

• Max. Blickwinkelbereich: von der Display-Mittelpunktachse 50° in alle Richtungen

• Befestigung nach DIN 43 834

1. Schieben Sie das Gerät von vorne durch den Schalttafelausschnitt. Zur Vermeidung von Wär-

mestaus empfehlen wir einen Abstand von >15 mm (>0,59 inch) zu Wänden und anderen 

Geräten.

2. Das Gerät waagrecht halten und die beiden Befestigungsspangen in gegenüberliegende Aus-

sparungen einhängen (entweder auf Gehäuseseite links und rechts, oder Ober- und Unter-

seite).

3. Die Schrauben der Befestigungsspangen gleichmäßig mit einem Schraubendreher anziehen, so 

dass eine sichere Abdichtung zur Schalttafel gewährleistet ist (Drehmoment: 100 Ncm).

! Hinweis! 

• Eine Anreihbarkeit der Geräte in Y-Richtung (vertikal übereinander) ist nur mit einem Abstand 

von min. 7 mm (0,28 inch) zwischen den Geräten möglich.
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• Eine Anreihbarkeit der Geräte in X-Richtung (horizontal nebeneinander) ist ohne Abstand mög-

lich.

• Das Rastermaß der Schalttafelausbrüche für mehrere Geräte muss (ohne Toleranzbetrachtung) 

horizontal min. 196,2 mm (7.72"), vertikal min. 156,2 mm (6.15") betragen.

4 Verdrahtung

4.1 Verdrahtung auf einen Blick

# Warnung! 

Beachten Sie, dass der gesamte elektrische Anschluss ausschließlich spannungsfrei vorgenommen 

werden darf.

" Achtung!

• Die Schutzleiterverbindung ist vor allen anderen Verbindungen herzustellen. Bei Unterbrechung 

des Schutzleiters können Gefahren auftreten.

• Vergleichen Sie vor Inbetriebnahme die Übereinstimmung der Versorgungsspannung mit den 

Angaben auf dem Typenschild (linke Gehäuseseite).

• Der gemischte Anschluss von Sicherheitskleinspannung und berührungsgefährlicher Spannung 

an den Relais ist nicht zulässig.

• Sehen Sie einen geeigneten Schalter oder Leistungsschalter in der Gebäudeinstallation vor. Dieser 

Schalter muss in der Nähe des Gerätes (leicht erreichbar) angebracht und als Trennvorrichtung 

gekennzeichnet sein.

• Für die Netzleitung ist ein Überstromschutzorgan (Nennstrom  10 A) erforderlich.

! Hinweis! 

Beachten Sie die Anschlussklemmenbezeichnung auf der Rückseite des Gerätes.

4.1.1 Farbzuordnung der Kanäle

Die Farbzuordnung der Kanäle erfolgt im Setup "Applikation -> Signal Gruppierung". Pro Gruppe 

stehen 8 vordefinierte Farben zur Verfügung, welchen die gewünschten Kanäle zugeordnet werden 

können.
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4.1.2 Schaltbild

Abb. 3: Schaltbild

! Hinweis! 

Abhängig von der Bestellung kann Slot 5 mit unterschiedlichen Karten (analogen oder digitalen Ein-

/Ausgängen) bestückt sein. Bitte beim Anschluss entsprechend Klemmenplan berücksichtigen.

Ethernet USB RS 232 / RS 485 Bus Interface
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4.1.3 Hilfsspannungsausgang als Messumformerspeisung für 2-Leiter-

Sensoren

Abb. 4: Anschluss des Hilfsspannungsausgangs bei Verwendung als Messumformerspeisung (MUS) für 2-Leiter-Sen-

soren im Strommessbereich
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4.1.4 Hilfsspannungsausgang als Messumformerspeisung für 4-Leiter-

Sensoren

Abb. 5: Anschluss des Hilfsspannungsausgangs bei Verwendung als Messumformerspeisung (MUS) für 4-Leiter-Sen-

soren im Strommessbereich
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4.2 Klemmenbelegung

" Achtung!

Ist bei langen Signalleitungen mit energiereichen Transienten zu rechnen, empfehlen wir die Vor-

schaltung eines geeigneten Überspannungsschutzes (z.B. E+H HAW560/562).

Verwenden Sie geschirmte Signalleitungen bei seriellen Schnittstellen!

4.2.1 Kabelspezifikation, Federklemmen

Sämtliche Anschlüsse auf der Geräterückseite sind als verpolungssichere Schraub- bzw. Feder-

klemmblöcke ausgeführt. Somit ist ein sehr schneller und einfacher Anschluss möglich. Die Feder-

klemmen werden mit einem Schlitzschraubendreher (Größe 0) betätigt.

Beim Anschluss ist folgendes zu beachten:

• Drahtquerschnitt Digital-I/O, RS485 und Analogeingänge: max. 1,5 mm2 (14 AWG) (Federklem-

men)

• Drahtquerschnitt Netz: max. 2,5 mm2 (13 AWG) (Schraubklemmen)

• Drahtquerschnitt Relais: max. 2,5 mm2 (13 AWG) (Federklemmen)

• Abisolierlänge: 10 mm (0,39 inch), 6 mm (0,24 inch) bei Netzklemme

! Hinweis! 

Beim Anschluss von flexiblen Leitungen an Federklemmen braucht keine Aderendhülse verwendet 

werden.

4.2.2 Anschluss der Schnittstellen

Ethernet, RS232/RS485 und USB-Anschluss

Details zum Anschluss der Schnittstellen finden Sie in der Betriebsanleitung auf CD-ROM, Kapitel 

4.2.

4.3 Schutzart

Das Gerät erfüllt frontseitig die Anforderungen gemäß Schutzart IP65.
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5 Inbetriebnahme und Bedienung

5.1 Funktionen - Handhabung im Betrieb

Abb. 6: Geräteanzeige / Bedieneinheiten
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Bedienelement 

(Pos.-Nr.)

Bedienfunktion

(Anzeigemodus = Messwertdarstellung)

(Setup-Modus = Bedienung im Setup-Menü)

1  "Navigator" Drehrad zur Bedienung mit zusätzlicher Drückfunktion.

Im Anzeigemodus: Durch Drehen kann zwischen den verschiedenen Signalgruppen umgeschaltet 

werden. Durch Drücken erscheint das Hauptmenü.

Im Setup-Modus bzw. in einem Auswahlmenü: Linksdrehung bewegt Markierungsbalken bzw. den 

Cursor nach oben bzw. links, ändert Parameter. Rechtsdrehung bewegt Markierungsbalken bzw. den 

Cursor nach unten bzw. nach rechts, ändert Parameter. Drücken = Auswahl der markierten Funk-

tion, Start der Parameteränderung (ENTER/Eingabetaste).

2 Funktionen der LED-Anzeigen (nach NAMUR NE44:)

• Grüne LED (oben) leuchtet: Spannungsversorgung OK, Gerät arbeitet störungsfrei

• Rote LED (unten) blinkt: Wartungsbedarf bei geräteexterner Ursache (z. B. Leitungsbruch etc.), 

bzw. es steht eine zu quittierende Meldung / Hinweis an, Abgleich läuft.

3  Variable "Softkey" Tasten 1...4 (von links nach rechts)

4 Funktionsanzeige der "Softkey" Tasten

5 Im Anzeigemodus: aktuelle Gruppenbezeichnung, Auswertungsart

Im Setup-Modus: Bezeichnung der aktuellen Bedienposition (Dialogtitel)
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5.2 Bediensprache einstellen

Die Bediensprache ist auf Englisch voreingestellt. Eine andere Bediensprache kann im Hauptmenü 

eingestellt werden.

Navigator drücken  -> Sprache/Language

Abb. 7: Ändern der Bediensprache im Hauptmenü

5.3 Inbetriebnahme

Nach Anlegen der Betriebsspannung leuchtet das Display und das Gerät ist funktionsbereit.

6 Im Anzeigemodus: Anzeige aktuelles Datum / Uhrzeit

Im Setup-Modus: --

7 Im Anzeigemodus: Benutzer-ID (wenn Funktion aktiv)

Im Setup-Modus: --

8 Im Anzeigemodus: Wechselanzeige, welcher Anteil der SD Karte bzw. des USB-Sticks (in %) bereits 

beschrieben ist.

Es werden auch Statussymbole (abwechselnd zur Speicherinfo) für folgende Funktionen angezeigt: 

Simulationsbetrieb, Datenspeicherung aktiv, Bediensperre, Charge aktiv 1)

Im Setup-Modus: Anzeige des aktuellen Bediencodes "Direct Access"

9 Im Anzeigemodus: Fenster zur Messwertdarstellung

Anzeige der aktuellen Messwerte und im Fehler-/Alarmzustand den Status, je nach gewählter Signal-

darstellung. Bei Zählern wird die Art des Zählers als Symbol dargestellt 1).

! Hinweis! 

Befindet sich eine Messstelle im Grenzwertzustand, wird die entsprechende Kanalbezeichnung rot 

hervorgehoben dargestellt (schnelles Erkennen von Grenzwerten). Während Sie das Gerät bedienen 

läuft die Messwerterfassung ununterbrochen weiter.

10 Im Anzeigemodus: Wechselnde Statusanzeige (z.B. eingestellter Zoom-Bereich) der Analog- bzw. 

Digitaleingänge in entsprechender Kanalfarbe.

Im Setup-Modus: Je nach Anzeigeart können hier verschiedene Informationen angezeigt werden.

a Steckplatz für SD Karte

" Achtung!

SD Karte nicht entnehmen, wenn gelbe LED (d) leuchtet! Gefahr von Datenverlust!

b USB-B-Buchse Typ "Function" z.B. für Laptop

c USB-A-Buchse Typ "Host" z.B. für USB-Stick

d LED am SD Steckplatz

Gelbe LED leuchtet, wenn das Gerät auf die SD Karte schreibt, bzw. liest.

" Achtung!

SD Karte nicht entnehmen, wenn gelbe LED leuchtet! Gefahr von Datenverlust!

1) Symbolübersicht siehe Betriebsanleitung auf CD-ROM.

Bedienelement 

(Pos.-Nr.)

Bedienfunktion

(Anzeigemodus = Messwertdarstellung)

(Setup-Modus = Bedienung im Setup-Menü)
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• Bei der Inbetriebnahme eines bereits konfigurierten oder voreingestellten Geräts werden die Mes-

sungen sofort gemäß den Einstellungen begonnen. Im Display erscheinen die Werte der aktuell 

eingestellten Anzeigegruppe.

• Bei der ersten Inbetriebnahme des Gerätes programmieren Sie das Setup gemäß den Beschreibun-

gen der Betriebsanleitung auf CD-ROM, Kapitel 6.3.

5.4 Kommunikation, PC Software installieren

! Hinweis! 

Um eine Kommunikation zwischen Gerät und PC herstellen zu können, muss mindestens die Ver-

sion V1.25.0.0 (oder höher) der mitgelieferten PC Software installiert sein. Zur Sicherheit sollten 

Sie die aktuelle PC Software (beiliegende CD-ROM) installierten.

5.4.1 Installation der mitgelieferten PC Software

! Hinweis! 

Zum Betrieb der  mitgelieferten PC Software muss der "Arial Unicode MS™" Font an Ihrem PC 

installiert sein. Ansonsten können gewisse Zeichen nicht oder falsch dargestellt werden. Überprüfen 

Sie dies an Ihrem PC unter "Systemsteuerung - Schriftarten". Sollte dieser Font nicht installiert sein, 

lesen Sie bitte in Ihrem Microsoft-Office® bzw. Microsoft-Windows® Handbuch nach.

! Hinweis! 

Zur Installation sind Administrator-Rechte erforderlich.

1. Installieren Sie die mitgelieferte PC Software auf Ihrem Rechner. Bei Bedarf können Sie die 

Bedienungsanleitung des Programms nach der Installation ausdrucken.

2. Nach erfolgreicher Installation können Sie die PC Software unter "Start -> Alle Programme" 

aufrufen.

5.4.2 Kommunikation über USB / USB-Treiber Installation

Nach erfolgreicher Installation der mitgelieferten PC Software kann das Gerät mit einem USB-Kabel 

am PC angeschlossen werden. Das Betriebssystem erkennt automatisch das neue USB-Gerät.

! Hinweis! 

Zur anschließenden Installation des USB-Treibers gehen Sie wie folgt vor (betriebssystemabhängig):

1. Das Windows-Fenster "Soll eine Verbindung mit Windows Update hergestellt werden, um 

nach Software zu suchen?" quittieren Sie mit "Nein, diesmal nicht" und "Weiter".

2. Das Windows-Fenster "Wie möchten Sie vorgehen?" quittieren Sie mit "Software automatisch 

installieren (empfohlen)" und "Weiter".

Nun können Sie die mitgelieferte PC Software starten, und eine Kommunikation mit dem Gerät 

herstellen.

" Achtung!

Zwischen erneutem Ein- und Ausstecken der USB-Verbindung vom PC zum Gerät mindestens 15 

Sekunden warten!
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5.4.3 Vorgehensweise Setup per Schnittstelle und mitgelieferter PC-

Software:

! Hinweis! 

Um diese Funktion nutzen zu können, muss das Gerät bereits in der PC-Datenbank angelegt sein, 

bzw. zuerst neu angelegt werden.

1. Geräteschnittstelle (RS232 / RS485, USB oder Ethernet) mit dem PC verbinden.

2. PC Software starten und neues Gerät in der PC-Datenbank anlegen:

- Wählen Sie "Gerät -> Geräteeinstellungen anzeigen/ändern /neues Gerät"

- Wählen Sie "Gerät -> Neues Gerät einfügen"

- Gerätebeschreibung eingeben. Zur Übertragung der Geräteeinstellungen wählen Sie die ent-

sprechende Geräteschnittstelle aus. Bestätigen Sie mit "Weiter". Wählen Sie die entsprechen-

den Schnittstellenparameter aus (muss mit den Einstellungen zur Kommunikation am Gerät 

übereinstimmen). Bestätigen Sie mit "Weiter". Es wird eine Zusammenfassung der Angaben 

zum neuen Gerät angezeigt. Mit "OK" wird eine Verbindung zum Gerät hergestellt und das 

neue Gerät in der PC-Datenbank angelegt.

3. Passen Sie die Geräteeinstellungen an und wählen Sie "Fertig -> Einstellungen an das Gerät 

senden". Die neuen Setup-Parameter werden automatisch auf das Gerät übertragen.

4. Abschließend sollten die Geräteeinstellungen in der Gerätedatenbank gespeichert werden. 

Wählen Sie "Fertig -> Einstellungen in der Gerätedatenbank speichern".

5.4.4 Setup per SD-Karte

Speichern Sie die Geräteeinstellungen am PC über die mitgelieferte PC-Software auf die SD-Karte. 

Dieses Setup-File kann anschließend in das Gerät übernommen werden.

! Hinweis! 

Um diese Funktion nutzen zu können, muss das Gerät bereits in der PC-Datenbank angelegt sein, 

bzw. zuerst neu angelegt werden. Außerdem muss ein SD-Kartensteckplatz am PC vorhanden sein.

" Achtung!

Entnehmen Sie die SD-Karte nie aus dem Gerät ohne vorher die Funktion "Extras -> SD-Karte -> 

Sicher entfernen" aufgerufen zu haben, da es sonst zu Datenverlust kommen kann.

Vorgehensweise Setup per SD-Karte:

1. Setup auf SD-Karte kopieren:

- Legen Sie eine formatierte SD-Karte ins Gerät ein.

- Wählen Sie im Menü Extras "SD-Karte -> Setup speichern".

- Wählen Sie im Menü Extras "SD-Karte -> Sicher entfernen".

- Entnehmen Sie die SD-Karte aus dem Gerät und stecken Sie sie in den SD-Kartensteckplatz 

im PC ein.

2. PC Software starten und neues Gerät in der PC-Datenbank anlegen:

- Wählen Sie "Gerät -> Geräteeinstellungen anzeigen/ändern /neues Gerät"

- Wählen Sie "Gerät -> Neues Gerät einfügen"

- Gerätebeschreibung eingeben. Zur Übertragung der Geräteeinstellungen wählen Sie "Para-

meterdatei von einem Datenträger (z.B. Diskette, ATA-Flash, CF, SD)". Bestätigen Sie mit 

"Weiter". Wählen Sie die entsprechende Geräte-Parameterdatei (*.rpd) von der SD-Karte aus. 

Bestätigen Sie mit "Weiter". Es wird eine Zusammenfassung der Angaben zum neuen Gerät 

angezeigt. Mit "OK" wird das neue Gerät in der PC-Datenbank angelegt.

3. Setup im PC-Programm anpassen und in der zugehörigen Datenbank speichern:

- Passen Sie die Geräteeinstellungen an.

- Wählen Sie "Fertig -> Einstellungen in der Gerätedatenbank speichern". Die neuen Setup-

Parameter werden in der PC-Datenbank gespeichert. Übertragen Sie das neue SETUP-File auf 

die SD-Karte in Ihrem PC: "Fertig -> Setup-Datenträger erstellen (Diskette / ATA-Flash / CF 

/ SD)" wählen und passendes Laufwerk selektieren.

- Entnehmen Sie die SD-Karte aus dem Steckplatz im PC und legen Sie sie in das Gerät ein.
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4. Neues Setup direkt am Gerät einlesen:

- Wählen Sie im Menü Extras "SD-Karte -> Setup laden". Zum Entnehmen der SD-Karte wäh-

len Sie im Menü Extras " SD-Karte -> Sicher entfernen". Wiederholen Sie diesen Vorgang, um 

auch weitere Geräte mit diesem Setup zu parametrieren.

" Achtung!

Wird diese Setup-SD-Karte nicht entnommen, beginnt nach ca. 5 Minuten die Messdatenspeiche-

rung. Die Setup-Daten bleiben weiterhin erhalten. Bitte die SD-Karte wechseln, wenn die Messda-

ten nicht auf dieser gespeichert werden sollen.

" Achtung!

Eine sichere Funktion ist nur mit der Original SD-Karte des Herstellers gewährleistet (siehe "Zube-

hör" Kapitel 8).

5.4.5 Setup per USB-Stick

Speichern Sie die Geräteeinstellungen am PC über die mitgelieferte PC-Software auf einen USB-

Stick. Dieses Setup-File kann anschließend in das Gerät übernommen werden.

! Hinweis! 

Um diese Funktion nutzen zu können, muss das Gerät bereits in der PC-Datenbank angelegt sein, 

bzw. zuerst neu angelegt werden. Außerdem muss eine freie USB-Buchse am PC vorhanden sein.

" Achtung!

Entnehmen Sie den USB-Stick nie aus dem Gerät ohne vorher die Funktion "Extras -> USB-Stick -

> Sicher entfernen" aufgerufen zu haben, da es sonst zu Datenverlust kommen kann.

Vorgehensweise Setup per USB-Stick:

1. Setup auf USB-Stick kopieren:

- Stecken Sie den USB-Stick in die USB-A-Buchse der Gerätefront bzw. Geräterückseite ein.

- Wählen Sie im Menü Extras "USB-Stick -> Setup speichern".

- Wählen Sie im Menü Extras "USB-Stick -> Sicher entfernen".

- Entnehmen Sie den USB-Stick aus dem Gerät und stecken Sie diesen in die USB-Buchse am 

PC.

2. PC Software starten und neues Gerät in der PC-Datenbank anlegen:

- Wählen Sie "Gerät -> Geräteeinstellungen anzeigen/ändern /neues Gerät"

- Wählen Sie "Gerät -> Neues Gerät einfügen"

- Gerätebeschreibung eingeben. Zur Übertragung der Geräteeinstellungen wählen Sie "Para-

meterdatei von einem Datenträger (z.B. Diskette, ATA-Flash, CF, SD)". Bestätigen Sie mit 

"Weiter". Wählen Sie die entsprechende Geräte-Parameterdatei (*.rpd) vom USB-Stick aus. 

Bestätigen Sie mit "Weiter". Es wird eine Zusammenfassung der Angaben zum neuen Gerät 

angezeigt. Mit "OK" wird das neue Gerät in der PC-Datenbank angelegt.

3. Setup im PC-Programm anpassen und in der zugehörigen Datenbank speichern:

- Passen Sie die Geräteeinstellungen an.

- Wählen Sie "Fertig -> Einstellungen in der Gerätedatenbank speichern". Die neuen Setup-

Parameter werden in der PC-Datenbank gespeichert. Übertragen Sie das neue SETUP-File auf 

den USB-Stick in Ihrem PC: "Fertig -> Setup-Datenträger erstellen (Diskette / ATA-Flash / CF 

/ SD)" wählen und passendes Laufwerk selektieren.

- Entnehmen Sie den USB-Stick aus dem PC und stecken Sie diesen in die USB-A-Buchse am 

Gerät.

4. Neues Setup direkt am Gerät einlesen:

- Wählen Sie im Menü Extras " USB-Stick -> Setup laden". Zum Entnehmen des USB-Sticks 

wählen Sie im Menü Extras " USB-Stick -> Sicher entfernen". Wiederholen Sie diesen Vor-

gang, um auch weitere Geräte mit diesem Setup zu parametrieren. 
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5.4.6 Setup direkt am Gerät (über Tasten/Navigator)

Tastenfunktionen im Setup

Die Funktion der Bedientasten wird in den Feldern direkt über den entsprechenden Tasten am Bild-

schirm beschrieben. Freie Felder bedeuten, dass die entsprechenden Tasten momentan ohne Funk-

tion sind.

• Drücken Sie den Navigator; das Hauptmenü wird angezeigt

• Wählen Sie mit dem Navigator das Menü "Setup"

• Bestätigen Sie durch erneutes Drücken des Navigators die Eingabe

• Mit der Softkey-Taste "Hilfe" kann zu dem ausgewählten Eintrag eine Hilfe angezeigt werden

• Die Softkey-Taste "Abbrechen" bzw. "Zurück" bedeutet ein Abbruch der Eingabe bzw. Rück-

sprung zu vorhergehendem Bild

! Hinweis! 

• Jeder Parameter wird über ein Dialogfenster geändert.

• Die geänderten Einstellungen werden erst wirksam, wenn Sie durch mehrmaliges Drücken von 

"Zurück" wieder in den Normalbetrieb zurückkehren (Setup-Übernahme mit "Ja" bestätigen). Bis 

zu diesem Zeitpunkt arbeitet das Gerät noch mit den vorherigen Daten.

Vorgehensweise zur Gerätekonfiguration / Setup:

! Hinweis! 

Nach der Inbetriebnahme (Geräte-Setup) sollte die SD-Karte und der interne Speicher gelöscht wer-

den, um die temporären Setupdaten zu löschen!

SD-Karte löschen: Extras -> SD-Karte -> Löschen

Internen Speicher löschen: Hauptmenü -> Diagnose / Simulation -> Internen Speicher löschen

Start



Systemeinstellungen (Sprache, Datum/Zeit, Kommunikation, Sicherheit, usw.)



Eingänge (Universaleingänge: Signaltyp, Eingangsbereich, usw.)



Eingänge (Digitaleingänge: Funktion, Bezeichnung, usw.)



Eingänge Mathematikkanäle (Option)



Ausgänge (Relais oder Analog-/Impulsausgänge - falls notwendig)



Applikationseinstellungen (Grenzwerte und Alarmrelais - falls notwendig)



Applikationseinstellungen (Signalgruppierung, Texte, Softkeys)



Ende
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Brief overview

For quick and easy commissioning:

Integrated Operating Instructions

The unit's simple control system enables you to perform commissioning for many applications 

without the need for hardcopy operating instructions. Your unit displays instructions at the push of 

a button directly on screen. These instructions are nevertheless delivered with the unit - they 

supplement the Operating Instructions in the unit. Anything that is not described directly at the unit 

by plain text or menus is explained here.

Fig. 1: Variable softkey (e.g. to call up the internal Help function in the Setup mode)

This document constitutes the Brief Operating Instructions. More detailed information 

can be found in the Operating Instructions and the additional instructions on the CD-

ROM supplied.

These Brief Operating Instructions do not act as a substitute for the Operating Instructions included 

in the scope of supply!

The complete device documentation comprises:

• These Brief Operating Instructions

• A CD-ROM with PDF files of:

– Operating Instructions

– Measuring principle fundamentals

– Approval and safety certificates

1. Observe the safety instructions Page 23



2. Mount the unit Page 24



3. Wire the unit Page 26



4. Install the PC operating software Page 33



5. Connect the unit to the PC Page 33



6. Configure the unit (via PC) Page 34



7. Transfer the setup data to the unit Page 34
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1 Safety instructions

1.1 Designated use

This unit is designed for the electronic acquisition, display, recording, analysis, remote transmission 

and archiving of analog and digital input signals in non-hazardous areas.

• The unit is designed for installation in a panel or a cabinet and may only be operated in an installed 

state.

• The manufacturer does not accept liability for damage caused by improper or non-designated use. 

The unit can cause danger if used improperly or other than intended.

1.2 Installation, commissioning and operation

• The unit may only be installed, connected, commissioned and serviced by qualified and 

authorized expert staff (e.g. electrical technicians) strictly adhering to the instructions contained 

in this manual, the applicable norms, legal regulations and certificates (depending on the 

application).

• These experts must have read and understood this manual and follow the instructions it contains.

• The unit may only be modified or repaired if expressly permitted in the Operating Instructions.

• Damaged units which could pose a source of danger may not be put into operation and must be 

marked as defective.

• Primarily observe local regulations regarding opening and repairing electrical units.

1.3 Operational safety

• The unit is safely built and tested according to state-of-the-art technology and has left the factory 

in perfect condition as regards technical safety. The applicable regulations and European standards 

have been taken into account.

• Please observe the technical data on the nameplate! The nameplate is on the left-hand side of the 

housing.

Electromagnetic compatibility

The measuring system meets the general safety requirements of IEC 61010 and the EMC 

requirements of IEC 61326.

Desktop version

# Warning! 

• The mains plug should only be inserted into a socket with a ground contact.

• The protective effect may not be suspended by an extension cable without a protective ground.

• Relay outputs: U (max) = 30 V rms (AC) / 60 V (DC)

1.4 Notes on safety conventions and icons

Always refer to the safety instructions in these Operating Instructions labeled with the following 

symbols:

# Warning! 

This symbol draws attention to activities or procedures that can lead to injuries to persons, safety 

risks or the destruction of the unit if not carried out properly.

" Caution! 

This symbol draws attention to activities or procedures that can lead to defective operation or to 

destruction of the unit if not carried out properly.

! Note! 

This symbol draws attention to activities or procedures that have an indirect effect on operation, or 

can trigger an unforeseen unit reaction if not carried out properly.
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ESD - Electrostatic discharge

Protect the terminals against electrostatic discharge. Failure to comply with this instruction can 

result in the destruction of parts of the electronics.

2 Identification

2.1 Scope of delivery

• Unit (with terminals, as per your order)

• 2 fastening clips

• USB interface cable, length 1.5 m (4.9 ft)

• Optional secure digital (SD) card (card not in device but is supplied.)

• PC operating and configuration software on CD-ROM

• Delivery note

• Multilanguage Brief Operating Instructions as hard copy

• Multilanguage Operating Instructions on CD-ROM

Anything missing? Then please inform your supplier.

3 Installation

3.1 Installation conditions

Working temperature range:

-10 to 50 °C (22 to 122 °F), max. 75% rel. humidity without condensation.

" Caution! 

• To avoid heat accumulation, please always ensure that the unit is sufficiently cooled.

• Maintain distance from strong magnetic fields (see Section 10 "Technical data", interference 

immunity)

• Permitted ambient conditions at front: in accordance with unit ingress protection of max. IP65 

(with front flap closed)

3.2 Installation instructions

3.2.1 Mounting tool

To install in the control panel, all you need is a screwdriver.
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3.2.2 Panel mounting, Installation dimensions

Fig. 2: Panel mounting and installation dimensions. All dimensions in mm or (inch)

• Installation depth without terminal cover: approx. 158 mm (6.22") (incl. terminals and fastening 

clips)

• Installation depth with terminal cover: approx. 197 mm (7,76")

• Panel cutout: 138+1 x 138+1 mm (5.43+0.04 x 5.43+0.04")

• Panel thickness: 2 to 40 mm (0.08 to 1.58")

• Max. viewing angle range: from the display central axis 50° in all directions

• Securing to DIN 43 834

1. Push the unit through the panel cutout from the front. To avoid heat accumulation, we 

recommend keeping a distance of > 15 mm (>0.59 inch) from the walls and other units.

2. Hold the unit horizontally and then hang the two jack screws in the openings opposite (either 

on left or right housing side, or at top or bottom).

3. Tighten the screws on the jack screws equally with a screwdriver such that a secure seal to the 

control panel is guaranteed (dynamometric screwdriver: 100 Ncm).

! Note! 

• A distance of min. 7 mm (0.28 inch) between the devices has to be observed if aligning the 

devices in the Y-direction (vertically above one another).
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• The devices can be arranged horizontally beside one another in the X direction without any 

spacing between the devices.

• The grid dimension of the panel cutouts for multiple devices must be min. 196.2 mm (7.72") 

horizontally and min. 156.2 mm (6.15") vertically (tolerance not considered).

4 Wiring

4.1 Quick wiring guide

# Warning! 

Please note that the entire electrical connection may only take place when the unit is de-energized.

" Caution! 

• The ground connection must be made before all other connections. Any interruption in the 

ground can cause danger.

• Before commissioning, compare the supply voltage with the information specified on the 

nameplate (left-hand side of the housing).

• The mixed connection of safety extra-low voltage and dangerous contact voltage to the relay is 

not permitted.

• Provide a suitable switch or circuit breaker when installing in a building. This switch must be 

installed near the unit (easily accessible) and be labeled as a separator.

• An overcurrent protective unit (nominal current  10 A) is required for the power cable.

! Note! 

Please also refer to the terminal designation on the rear of the unit.

4.1.1 Color assignment of the channels

Colors are assigned to the channels in Setup "Application –> Signal groups". 8 predefined colors are 

available per group and can be assigned to the desired channels.
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4.1.2 Circuit diagram

Fig. 3: Circuit diagram

! Note! 

Depending on the order, slot 5 can be assigned different cards (analog or digital inputs/outputs). 

When connecting, please take the corresponding terminal diagram into account.

Ethernet USB RS 232 / RS 485 Bus Interface
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4.1.3 Auxiliary voltage output as transmitter power supply for 2-wire 

sensors

Fig. 4: Connecting the auxiliary voltage output when using as transmitter power supply for 2-wire sensors in the 

current measuring range
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4.1.4 Auxiliary voltage output as transmitter power supply for 4-wire 

sensors

Fig. 5: Connecting the auxiliary voltage output when using as transmitter power supply for 4-wire sensors in the 

current measuring range
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4.2 Terminal assignment

" Caution! 

If high-energy transients occur when using long signal cables, we recommend connecting a suitable 

overvoltage protection (e.g. E+H HAW560/562).

Use shielded signal lines for serial interfaces!

4.2.1 Cable specification, spring terminals

All connections on the rear of the unit are designed as screw or spring terminal blocks with reverse 

polarity protection. This makes the connection very quick and easy. The spring terminals are 

actuated with a slotted screwdriver (size 0).

Please note the following when connecting:

• Wire cross-section, digital I/O, RS485 and analog inputs: max. 1.5 mm2 (14 AWG) (spring 

terminals)

• Wire cross-section, power supply: max. 2.5 mm2 (13 AWG) (screw terminals)

• Wire cross-section, relays: max. 2.5 mm2 (13 AWG) (spring terminals)

• Stripped length: 10 mm (0.39 inch), 6 mm (0.24 inch) for power terminal

! Note! 

No ferrules have to be used when connecting flexible wires to spring terminals.

4.2.2 Connecting the interfaces

Ethernet, RS232/RS485 and USB connection

Details on connecting the interfaces can be found in the Operating Instructions on CD-ROM, chap-

ter 4.2.

4.3 Degree of protection

At the front, the unit meets the requirements of ingress protection IP65.
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5 Commissioning and operation

5.1 Display and operating elements

Fig. 6: Device display/operating units

5

9

8

4

3

d

c b a

1

2

6 7

10

Operating 

element (Item 

No.)

Operating function

(Display mode = measured value display)

(Setup mode = operating in the Setup menu)

1  "Navigator" jog/shuttle dial for operating with additional press function.

In the Display mode: turn the dial to switch between the various signal groups. Press the dial to 

display the main menu.

In the Setup mode or in a selection menu: turn the dial anticlockwise to move the bar or the cursor 

upwards or counterclockwise, changes the parameter. Turning clockwise moves the bar or cursor 

down or clockwise, changes parameter. Press = selects the highlighted function, starts parameter 

change (ENTER).

2 Functions of the LED display (as per NAMUR NE44:)

• Green LED (top) lights up: power supply OK, unit working without faults

• Red LED (bottom) flashes: need for maintenance if unit-external problem occurs (e.g. cable open 

circuit etc.) or a message / note to be acknowledged is pending, calibration in progress.

3  Variable softkeys 1 to 4 (from left to right)

4 Function indicator of the softkey

5 In the Display mode: current group name, type of evaluation

In the Setup mode: name of the current operating item (dialog title)
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5.2 Configuring the operating language

The default setting for the operating language is English. A different operating language can be 

configured in the main menu.

Press the Navigator  -> Language

Fig. 7: Changing the operating language in the main menu

5.3 Commissioning

Once the operating voltage is applied, the display lights up and the unit is ready for operation.

6 In the Display mode: displays current date/time

In the Setup mode: --

7 In the Display mode: user ID (if the function is enabled)

In the Setup mode: --

8 In the Display mode: alternating display indicating what percentage of the SD card or USB stick has 

already been written to.

Status symbols are displayed for the following functions (alternate with the memory information): 

simulation mode, data storage active, operating lock, batch active 1)

In the Setup mode: the current "direct access" operating code is displayed

9 In the Display mode: screen for measured value display

Displays the current measured values, and the status in a fault/alarm condition, depending on the 

signal display selected. In the case of counters, the type of counter is displayed as a symbol 1).

! Note! 

If a measuring point has limit value status, the corresponding channel identifier is highlighted in red 

(quick detection of limit values). When you are operating the unit, measured value acquisition 

continues to run without interruption.

10 In the Display mode: alternating status display (e.g. set zoom range) of the analog or digital inputs in 

the appropriate color of the channel.

In the Setup mode: different information can be displayed here depending on the display type.

a Slot for SD card

" Caution! 

Do not remove the SD card if the yellow LED (d) is lit! Risk of data loss!

b USB B socket type "function" e.g. for laptop

c USB A socket type "host" e.g. for USB stick

d LED at SD slot

Yellow LED lit when the unit writes to the SD card or reads it.

" Caution! 

Do not remove the SD card if the yellow LED is lit! Risk of data loss!

1) Overview of symbols, see Operating Instructions on CD-ROM.

Operating 

element (Item 

No.)

Operating function

(Display mode = measured value display)

(Setup mode = operating in the Setup menu)
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• If you are commissioning a unit that is already configured, measuring is immediately started in 

accordance with the settings. The values of the display group currently configured appear on the 

display.

• When you first commission the unit, program the set up in accordance with the description in the 

Operating Instructions on CD-ROM, chapter 6.3.

5.4 Communication; PC software installation

! Note! 

Version V1.25.0.0 (or higher) of the PC software supplied must be installed to be able to establish 

communication between the unit and the PC. To be on the safe side, you should install the current 

PC software package (CD–ROM supplied).

5.4.1 Installing the PC software supplied

! Note! 

The "Arial Unicode MS™" font must be installed on your PC to operate the PC software supplied. 

Otherwise certain characters might be displayed incorrectly or not at all. Check this on your PC 

under "Control Panel - Fonts". If this font is not installed, please refer to your Microsoft-Office® or 

Microsoft-Windows® manual.

! Note! 

You need administrator rights to install the software.

1. Install the supplied PC software on your computer. The program's Operating Instructions can 

be printed out after installation, if required.

2. Once the PC software has been installed successfully, you can launch the software under "Start 

-> All programs".

5.4.2 Communication via USB / USB driver installation

Once the PC software supplied has been installed successfully, the unit can be connected to the PC 

with a USB cable. The operating system automatically recognizes the new USB unit.

! Note! 

Proceed as follows to then install the USB driver (depends on operating system):

1. The Windows prompt "Should a connection be established with Windows Update to look for 

software?" appears. Click "No, not this time" and then "Next".

2. The "What do you want the wizard to do?" window appears. Select "Install the software 

automatically (Recommended)" and then click "Next".

You can now start the PC software supplied to establish communication with the unit.

" Caution! 

Wait at least 15 seconds before plugging in and out the USB connection from the PC to the unit!
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5.4.3 Procedure for setup via interface and PC software supplied:

! Note! 

In order to be able to use this function, the unit must already be created in the PC database or has 

to be created beforehand.

1. Connect the unit interface (RS232 / RS485, USB or Ethernet) to the PC.

2. Start the PC software and create a new unit in the PC database:

- Select "Unit -> Display/change unit setup/Add new unit"

- Select "Unit -> Add new unit"

- Enter unit identifier. To transmit the unit setup select the corresponding unit interface. 

Confirm with "Next". Select the corresponding interface parameters (must match the settings 

for communicating at the device). Confirm with "Next". A summary of the information on the 

new unit is displayed. When you click "OK", a connection is established to the unit and the 

new unit is created in the PC database.

3. Adjust the unit settings and select "Finished -> Send setup to unit". The new setup parameters 

are automatically transferred to the unit.

4. Finally, the unit settings should be saved in the unit database. Select "Finished -> Save setup 

in unit database".

5.4.4 Setup via SD card

Save the unit settings on the PC onto the SD card using the PC software supplied. This setup file 

can then be imported into the unit.

! Note! 

In order to be able to use this function, the unit must already be created in the PC database or has 

to be created beforehand. In addition, there has to be an SD card slot on the PC.

" Caution! 

Never remove the SD card from the unit without previously launching the function "Extras –> SD 

card –> Remove safely" as data could be lost otherwise.

Procedure for setup using an SD card:

1. Copy setup to SD card:

- Insert a formatted SD card into the unit.

- In the Extras menu, select "SD card -> Save setup".

– In the Extras menu, select "SD card –> Remove safely".

– Remove the SD card from the unit and insert it into the SD card slot at the PC.

2. Start the PC software and create a new unit in the PC database:

– Select "Unit –> Display/change unit setup/Add new unit"

– Select "Unit –> Add new unit"

– Enter unit identifier. Select "Parameter file from a data source (e.g. diskette, ATA Flash, CF, 

SD)" to transmit the unit setup. Confirm with "Next". Select the corresponding unit parameter 

file (*.rpd) from the SD card. Confirm with "Next". A summary of the information on the new 

unit is displayed. When you click "OK", the new unit is created in the PC database.

3. Adjust setup in the PC program and save in the associated database:

- Adjust the unit settings.

– Select "Finished –> Save setup in unit database". The new setup parameters are saved in the 

PC database. Transfer the new SETUP file to the SD card in your PC: select "Finished –> Create 

setup data carrier (diskette/ATA flash/CF/SD)" and select the suitable drive.

– Remove the SD card from the slot in the PC and insert it into the unit.

4. Read in new setup directly at the unit:

– In the Extras menu, select "SD card –> Load setup". To remove the SD card, select "SD card 

–> Safe removal" in the Extras menu. Repeat these steps to configure additional units with this 

setup.
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" Caution! 

If the setup SD card is not removed, the measurement data will begin to be saved after approx. 5 

minutes. The setup data are still kept. Please change the SD card if the measurement data are not 

meant to be saved onto this card.

" Caution! 

Correct and safe functioning is only guaranteed with genuine SD cards of the manufacturer (see 

"Accessories", Section 8).

5.4.5 Setup via USB stick

Save the unit settings on the PC onto a USB stick using the PC software supplied. This setup file can 

then be imported into the unit.

! Note! 

In order to be able to use this function, the unit must already be created in the PC database or has 

to be created beforehand. In addition, there has to be a free USB socket on the PC.

" Caution! 

Never remove the USB stick from the unit without previously launching the function "Extras –> 

USB stick –> Remove safely" as data could be lost otherwise.

Procedure for setup using a USB stick:

1. Copy the setup to the USB stick:

– Insert the USB stick into the USB A socket on the unit front or rear.

– In the Extras menu, select "USB stick –> Save setup".

– In the Extras menu, select "USB stick –> Remove safely".

– Remove the USB stick from the unit and insert it into the USB socket on the PC.

2. Start the PC software and create a new unit in the PC database:

– Select "Unit –> Display/change unit setup/Add new unit"

– Select "Unit –> Add new unit"

– Enter unit identifier. Select "Parameter file from a data source (e.g. diskette, ATA Flash, CF, 

SD)" to transmit the unit setup. Confirm with "Next". Select the corresponding unit parameter 

file (*.rpd) from the USB stick. Confirm with "Next". A summary of the information on the 

new unit is displayed. When you click "OK", the new unit is created in the PC database.

3. Adjust setup in the PC program and save in the associated database:

- Adjust the unit settings.

– Select "Finished –> Save setup in unit database". The new setup parameters are saved in the 

PC database. Transfer the new SETUP file to the USB stick in your PC: select "Finished –> 

Create setup data carrier (diskette/ATA flash/CF/SD)" and select the suitable drive.

– Remove the USB stick from the PC and insert it into the USB A socket on the unit.

4. Read in new setup directly at the unit:

– In the Extras menu, select "USB stick –> Load setup". To remove the USB stick, select "USB 

stick –> Safe removal" in the Extras menu. Repeat these steps to configure additional units with 

this setup. 
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5.4.6 Setup directly at the unit (using keys/navigator)

Key functions in the setup

The function of the operating keys is described in the fields directly above the corresponding keys 

on the screen. Free fields mean that no function is currently assigned to the keys in question.

• Press the navigator; the main menu is displayed

• Using the navigator, select the "Setup" menu

• Press the navigator again to confirm your entry

• Use the softkey "Help" to call up the Help on the entry selected.

• The "Cancel" or "Back" softkey cancels entries or returns to the previous screen.

! Note! 

• Every parameter is modified via a dialog box.

• The modified settings do not take effect until you return to the normal operating mode by pressing 

"Back" repeatedly (confirm setup is accepted with "Yes"). Until this time, the unit still works with 

the previous data.

Procedure for unit configuration/setup:

! Note! 

After commissioning (unit setup), the SD card and the internal memory should be cleared to delete 

the temporary setup data!

Deleting the SD card: Extras -> SD card -> Delete

Deleting the internal memory: Main menu -> Diagnosis / Simulation -> Delete internal memory

Start



System settings (language, date/time, communication, safety, etc.)



Inputs (universal inputs: signal type, input range, etc.)



Inputs (digital inputs: function, designation, etc.)



Inputs for mathematics channels (option)



Outputs (relay or analog/pulse outputs - if necessary)



Application settings (limit values and alarm relays - if necessary)



Application settings (signal grouping, text, softkeys)



End
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Aperçu

Pour une mise en service simple et rapide :

Mise en service intégrée

Le concept de configuration simple de votre appareil permet, pour de nombreuses applications, une 

mise en service sans manuel papier. Votre appareil affiche directement des conseils d'utilisation sur 

simple activation d'une touche. Cependant le présent manuel est aussi fourni avec le matériel livré 

- il est complémentaire des conseils de mise en service intégrés à l'appareil. Vous trouverez ici des 

explications qui ne figurent pas en texte clair ou dans des listes de sélection dans l'appareil. 

Fig. 1 :  Touche (softkey) variable (par ex. pour l'interrogation de la fonction aide dans le mode configuration)

Les présentes instructions sont condensées. Des instructions détaillées figurent dans le 

manuel de mise en service et les instructions supplémentaires sur le CD-ROM fourni. 

Ces instructions condensées ne remplacent pas  le manuel de mise en service fourni avec le matériel 

livré !

La documentation d'appareil complète comprend : 

• les présentes instructions condensées 

• un CD-ROM avec les fichiers PDF suivants : 

– Manuel de mise en service

– Bases du principe de mesure

– Certificats d'agréments et de sécurité

1. Tenir compte des conseils de sécurité v. page 41



2. Monter l'appareil v. page 42



3. Câbler l'appareil v. page 44



4. Installer le logiciel d'exploitation PC v. page 51



5. Relier l'appareil au PC v. page 51



6. Paramétrer l'appareil (via PC) v. page 52



7. Transmettre les paramètres de configuration dans l'appareil v. page 52
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1 Conseils de sécurité

1.1 Utilisation conforme à l'objet

Le présent appareil est destiné à la mesure, l'affichage, la représentation, l'exploitation, la transmis-

sion à distance et l'archivage de signaux d'entrée analogiques et digitaux en zones non explosibles. 

• L'appareil est prévu pour un montage en armoire électrique et ne doit être exploité qu'après avoir 

été installé. 

• La garantie du fabricant ne couvre pas les dommages résultant d'une utilisation non conforme à 

l'objet. Si l'appareil n'est pas utilisé de manière conforme, il peut être source de dangers.

1.2 Montage, mise en service et utilisation

• L'appareil ne doit être installé, raccordé, mis en service et entretenu que par un personnel spécia-

lisé, qualifié et autorisé (par ex. électricien), qui respectera strictement les présentes instructions, 

les normes en vigueur, les directives locales et les certificats (selon l'application). 

• Le personnel spécialisé doit impérativement avoir lu, compris et suivi les présentes instructions.

• Des modifications et réparations de l'appareil peuvent uniquement être effectuées si ceci est 

expressément spécifié dans les instructions. 

• Les appareils endommagés qui pourraient constituer une source de dangers ne doivent pas être 

mis en service et être marqués comme défectueux. 

• Tenir compte des réglementations nationales en matière d'ouverture et de réparation d'appareils 

électriques.

1.3 Sécurité de fonctionnement

• L'appareil a été construit d'après les derniers progrès techniques et a quitté nos établissements 

dans un état irréprochable. Les directives et normes européennes en vigueur ont été respectées. 

• Tenir compte des caractéristiques techniques sur la plaque signalétique ! La plaque signalétique 

se trouve sur la paroi gauche de l'appareil.

Protection contre les rayonnements électromécaniques

L'ensemble de mesure remplit toutes les exigences générales de sécurité selon CEI 61010 ainsi que 

les exigences CEM selon CEI 61326

Version de table

# Danger ! 

• Le connecteur d'alimentation ne doit être inséré que dans une prise munie d'une fiche de terre. 

• Le protection ne doit pas être compromise par l'utilisation d'une rallonge sans fil de terre. 

• Sortie relais : U (max) = 30 V eff (AC) / 60 V (DC)

1.4 Symboles de sécurité utilisés

Veuillez observer les remarques sur les éventuels dangers mis en évidence par les pictogrammes 

suivants :

# Danger ! 

Ce symbole signale des activités ou procédures qui risquent d'entrainer des dommages corporels ou 

la destruction de l'appareil si elles n'ont pas été menées correctement. 

" Attention ! 

Ce symbole signale les actions ou les procédures qui risquent d'entraîner des dysfonctionnements 

ou la destruction de l'appareil si elles n'ont pas été menées correctement.
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! Remarque ! 

Ce symbole signale les actions ou procédures susceptibles de perturber indirectement le fonction-

nement des appareils ou de générer des réactions imprévues si elles n'ont pas été menées correcte-

ment.

ESD - Electrostatic discharge

Protéger les bornes contre tout risque de décharge électrostatique. Un non repect peut entrainer la 

destruction de composants de l'électronique.

2 Identification

2.1 Ensemble livré

• Appareil (avec bornes, selon votre commande)

• 2 étriers de fixation à visser

• Câble interface USB, longueur 1,5 m (4.9 ft)

• En option carte Secure Digital SD (carte non intégrée à l'appareil mais cependant fournie)

• Logiciel de commande et de paramétrage PC sur CD-ROM

• Bulletin de livraison

• Instructions condensées sous forme papier

• Manuel de mise en service multilingue sur CD-ROM

Eléments manquants ? Veuillez en informer votre fournisseur !

3 Montage

3.1 Conditions d'implantation

Gamme de température de service :

-10 à 50 °C (22 à 122 °F), humidité relative max. 75% sans condensation.

" Attention ! 

• Pour éviter les accumulations de chaleur, assurer en permanence un refroidissement suffisant de 

l'appareil.

• Respecter un écart par rapport aux champs magnétiques (voir chap. 10 "Caractéristiques techni-

ques", Résistivité)

• Condition environnante admissible en face avant : selon degré de protection de l'appareil max. 

IP65 (avec capot frontal fermé)

3.2 Montage

3.2.1 Outils de montage

Il suffit d'un tournevis pour procéder au montage en armoire électrique.
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3.2.2 Montage en armoire électrique, dimensions de montage

Fig. 2 :  Montage en armoire électrique et dimensions. Toutes les indications en mm ou (Inch)

• Profondeur de montage sans couvercle bornier : env. 158 mm (6,22") (y compris bornes de rac-

cordement et étriers de fixation)

• Profondeur de montage avec couvercle bornier : env. 197 mm (7,76")

• Découpe d'armoire électrique : 138+1 x 138+1 mm (5,43+0,04 x 5,43+0,04")

• Epaisseur armoire électrique : 2 à 40 mm (0,08 à 1,58")

• Angle de lecture max. : de l'axe médian de l'affichage 50° dans toutes les directions

• Fixation selon DIN 43 834

1. Insérer l'appareil par l'avant à travers la découpe de l'amoire. Pour éviter les accumulations de 

chaleur, nous recommandons un écart > 15 mm (> 0,59 inch) par rapport aux parois et autres 

appareils.

2. Tenir l'appareil horizontal et accrocher les deux étriers de fixation dans les encoches prévues 

(soit sur les côtés droit et gauche du boitier, soit sur les faces inférieure et supérieure). 

3. Serrer régulièrement les vis des étriers de fixation avec un tournevis, de manière à assurer une 

bonne étanchéité avec l'armoire (couple de rotation 100 Ncm).

! Remarque ! 

• Un alignement des appareils dans le sens Y (verticalement ou les uns au-dessus des autres) est 

seulement possible avec un écart de 7 mm (0,28 inch) entre les appareils. 

195.2
(7.69)

1
4

9
.2

(5
.8

7
)

Y

X

138
(5.43 )

+1

+0.04

7
(0

.2
8

)
138 (5.43)

196.2 (7.72)

58.2 (2.29)

1
3

8
(5

.4
3

)

1
5

6
.2

(6
.1

5
)

1
8

.2
(0

.7
2

)

157.8 (6.21)

141 (5.55)

1
0

5
.5

(4
.1

5
)

23.3 (0.92)

35.1
(1.38)

1
3

8
(5

.4
3

)

5
(0.2)

192 (7.56)



Câblage

44

• Un alignement des appareils dans le sens X (horizontalement ou les uns à côté des autres) est pos-

sible sans écart. 

• Les dimensions des découpes d'armoire pour plusieurs appareils doivent être (sans prise en 

compte des tolérances) horizontalement d'au moins 196,2 mm (7,72 inch), et verticalement d'au 

moins 156,2 mm (6,15 inch).

4 Câblage

4.1 Raccordement en bref

# Danger ! 

Noter que tous les branchements électriques doivent être effectués hors tension. 

" Attention ! 

• Réaliser la liaison à la terre avant toutes les autres. Une rupture du câble de terre peut être source 

de dangers.

• Avant la mise en service comparer la tension d'alimentation avec les indications sur la plaque 

signalétique (côté gauche de l'appareil).

• Le raccordement mixte de faibles tensions et de tensions dangereuses au relais n'est pas admissi-

ble.

• Prévoir un contacteur ou un disjoncteur approprié à l'intérieur du bâtiment où se trouve l'instal-

lation. Ce contacteur doit se trouver à proximité de l'appareil (facilement accessible) et être mar-

qué comme sectionneur.

• Le câble de réseau nécessite un parafoudre (courant nominal 10 A).

! Remarque ! 

Tenir également compte de la désignation des bornes de raccordement au dos de l'appareil. 

4.1.1 Affectation des couleurs de voies

L'affectation des couleurs de voies se fait dans la configuration"Application -> Groupement signal". 

Huit couleurs prédéfinies sont disponibles par groupe ; elles peuvent être affectées aux voies sou-

haitées. 
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4.1.2 Schéma électrique

Fig. 3: Schéma électrique

! Remarque ! 

En fonction de la commande, Slot 5 peut être équipé de différentes cartes (entrées/sorties analogi-

ques ou digitales). Tenir compte du schéma des bornes lors du raccordement.
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4.1.3 Sortie tension auxiliaire comme alimentation de transmetteur 

pour capteurs 2 fils

Fig. 4 :  Raccordement de la sortie tension auxiliaire lors de l'utilisation comme alimentation de transmetteur (MUS) 

pour les capteurs 2 fils dans la gamme de mesure de courant
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4.1.4 Sortie tension auxiliaire comme alimentation de transmetteur 

pour capteurs 4 fils

Fig. 5 :  Raccordement de la sortie tension auxiliaire lors de l'utilisation comme alimentation de transmetteur (MUS) 

pour les capteurs 4 fils dans la gamme de mesure de courant
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4.2 Occupation des bornes

" Attention ! 

S'il faut s'attendre à des parasites sur des câbles de signal longs, nous recommandons de mettre en 

place en amont un parafoudre approprié (par ex. E+H HAW 560/562).

Utiliser des câbles de signal blindés pour les interfaces sérielles !

4.2.1 Spécification de câble, bornes à ressort

Tous les raccordements au dos de l'appareil se font par des borniers à visser et à ressort avec détrom-

peurs. Ceci simplifie le raccordement et le rend plus rapide. Les bornes à ressort sont actionnées à 

l'aide d'un tournevis cruciforme (taille 0).

Lors du raccordement tenir compte des points suivants :

• Section de fil E/S digitale, RS485 et entrées analogiques : max. 1,5 mm2 (14 AWG) (bornes à res-

sort)

• Section de fil réseau : max. 2,5 mm2 (13 AWG) (bornes à ressort)

• Section de fil relais : max. 2,5 mm2 (13 AWG) (bornes à ressort)

• Longueur à dénuder : 10 mm (0,39 inch), 6 mm (0,24 inch) pour la borne de réseau

! Remarque ! 

Lors du raccordement de câbles flexibles aux bornes à ressort, il n'est pas nécessaire de prévoir une 

douille de terminaison. 

4.2.2 Raccordement des interfaces

Ethernet, RS232/RS485 et raccordement USB

Les détails relatifs au raccordement des interfaces figurent sur le CD-ROM, chapitre 4.2.

4.3 Protection

L'appareil répond, en face avant, aux exigences de la protection IP65.



Mise en service et utilisation

49

5 Mise en service et utilisation

5.1 Fonctions - Manipulation en cours de service

Fig. 6 :  Affichage d'appareil / Unités de commande
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Elément de 

commande 

(pos. N°)

Fonction de commande

(Mode d'affichage = représentation de la mesure)

(Mode configuration = exploitation dans le menu configuration)

1  Commutateur rotatif "Navigateur" avec fonction d'activation supplémentaire.

Dans le mode affichage : 

En tournant, on peut commuter entre les différents groupes de signal. 

En appuyant on fait apparaitre le menu principal.

En mode Configuration ou dans un menu de sélection : la rotation vers la gauche déplace le marqueur 

ou le curseur vers le haut resp. la gauche, et modifie les paramètres. La rotation vers la droite déplace 

le marqueur ou le curseur vers le bas resp. la droite, et modifie les paramètres. Appuyer = sélection de 

la fonction marquée, démarrage de la modification de paramètre (ENTER/Touche d'entrée).

2 Fonctions des affichages DEL (selon NAMUR NE44)

• DEL verte (en haut) est allumée : tension d'alimentation OK, appareil fonctionne correctement

• DEL rouge (en-bas) clignote : maintenance nécessaire pour une cause externe (par ex. rupture de 

câble etc) ou présence d'un message/remarque à acquitter, étalonnage en cours.

3  Touches "Softkey" variables 1...4 (de la gauche vers la droite)

4 Affichage de fonction des touches "Softkey" 

5 Dans le mode affichage : désignation actuelle de groupe, type d'exploitation

Dans le mode configuration : désignation de la position de commande actuelle (titre de dialogue)
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5.2 Régler la langue de service

La langue de service est réglée sur Anglais. Une autre langue de service peut être réglée dans le 

menu principal.

Appuyer sur le navigateur  -> Langue/Language

Fig. 7 :  Modification de la langue dans le menu principal

6 Dans le mode affichage : affichage de la date/de l'heure actuelle

Dans le mode configuration : --

7 Dans le mode affichage : ID utilisateur (si fonction active) 

Dans le mode configuration : --

8 Dans le mode affichage : affichage alternatif du volume de la carte SD ou de la clé USB (en %) déjà 

rempli. 

Les symboles d'état sont également affichés (en alternance avec l'info mémoire) pour les fonctions sui-

vantes : mode simulation, mémorisation des données active, verrouillage, charge active 1)

Dans le mode configuration : affichage du code d'utilisation actuel "Direct Access"

9 Dans le mode affichage : Fenêtre pour la représentation de la mesure

Affichage des valeurs mesurées actuelles et en cas de défaut/d'alarme l'état en fonction de la repré-

sentation du signal choisie. Ce type de compteur est représenté comme symbole. 1).

! Remarque ! 

Si un point de mesure se trouve en dépassement de seuil, la désignation de la voie correspondante est 

représentée en rouge (reconnaissance rapide des valeurs de seuils). Pendant que vous utilisez l'appa-

reil, l'enregistrement des valeurs mesurées continue de tourner.

10 Dans le mode affichage : Affichage d'état alterné (par ex. gamme zoom réglée) des entrées analogiques 

ou digitales dans la couleur de voie correspondante. 

Dans le mode configuration : selon le type d'affichage, on peut afficher différentes informations. 

a Emplacement pour carte SD

" Attention ! 

Ne pas déposer la carte SD si la DEL jaune (d) est allumée ! Risque de perte de données !

b Prise USB-B Type "Function" par ex. pour ordinateur portable

c Prise USB-A type "Host" par ex. pour clé USB 

d DEL à l'emplacement SD

DEL jaune est allumée lorsque l'appareil écrit ou lit des données sur la carte SD.

" Attention ! 

Ne pas déposer la carte SD si la DEL jaune (d) est allumée ! Risque de perte de données !

1)  Symboles utilisés voir Manuel de mise en service sur le CD-ROM!

Elément de 

commande 

(pos. N°)

Fonction de commande

(Mode d'affichage = représentation de la mesure)

(Mode configuration = exploitation dans le menu configuration)
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5.3 Mise en service

Après mise sous tension l'afficheur s'allume et l'appareil est prêt à fonctionner. 

• Lors de la mise en service d'un appareil déjà configuré ou préréglé, les mesures sont effectuées 

immédiatement, conformément aux réglages. Dans l'affichage apparaissent les valeurs du groupe 

actuellement réglées. 

• Lors de la première mise en service de l'appareil, vous réalisez la configuration conformément aux 

descriptions du Manuel de mise en service sur CD-ROM, chapitre 6.3.

5.4 Communication, installation du logiciel PC

! Remarque ! 

Pour pouvoir établir une communication entre l'appareil et le PC il faut au moins que la version 

V1.25.0.0 (ou supérieure) du logiciel PC fourni soit installée. Pour plus de sécurité, il faudrait ins-

taller le logiciel PC actuel (CD-ROM fourni).

5.4.1 Installation du logiciel PC fourni

! Remarque ! 

Pour l'utilisation du logiciel PC fourni il faut installer la fonte "Arial Unicode MS™" dans le PC. Dans 

le cas contraire, certains caractères ne pourront être représentés ou le seront mal. Vérifer ceci sur 

votre PC sous "Commande système - Fontes". Si cette fonte n'est pas encore installée, veuillez-vous 

référer à votre manuel Microsoft-Office® ou Microsoft-Windows®.

! Remarque ! 

Des droits d'aministrateur sont nécessaires pour l'installation. 

1. Installer le logiciel PC livré sur votre ordinateur. Le cas échéant vous pouvez imprimer le 

manuel du programme après l'installation.

2. Après l'installation vous pouvez interroger le logiciel PC sous "Démarrage -> Tous les program-

mes".

5.4.2 Communication via USB / driver USB

Après installation du logiciel PC fourni, il est possible de relier l'appareil au PC au moyen d'un câble 

USB. Le système d'exploitation reconnait automatiquement le nouvel appareil USB. 

! Remarque ! 

Pour l'installation du driver USB, procéder comme suit (en fonction du système d'exploitation) :

1. La fenêtre Windows "Faut-il réaliser une liaison avec Windows pour rechercher le logiciel ?" 

doit être acquittée avec "Non" et "Continuer".

2. La fenêtre "Comment procéder ?" doit être acquittée avec "Installer le logiciel automatique-

ment (recommandé)" et "Continuer". 

Vous pouvez maintenant démarrer le logiciel PC fourni et établir une communication avec l'appa-

reil. 

" Attention ! 

Il convient d'attendre au moins 15 secondes avant de rétablir une liaison USB entre PC et appareil 

qui a été déconnectée !
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5.4.3 Procédure de configuration via interface / logiciel PC fourni :

! Remarque ! 

Pour pouvoir utiliser cette fonction il faut que l'appareil figure déjà dans la base de données PC ou 

bien il convient de l'installer. 

1. Relier l'interface (RS232 / RS485, USB ou Ethernet) au PC.

2. Démarrer le logiciel PC et installer le nouvel appareil dans la base de données PC : 

- Sélectionner "Appareil -> Afficher/modifier la configuration de l'appareil/Nouvel appareil"

- Sélectionner "Appareil - Insérer nouvel appareil"

- Entrer la description d'appareil. Pour la transmission des réglages d'appareil vous sélectionnez 

l'interface correspondante. Confirmer avec "Poursuivre". Sélectionnez les paramètres d'inter-

face correspondants (doivent concorder avec les réglages pour la communication à l'appareil). 

Confirmer avec "Poursuivre". Un résumé des indications relatives au nouvel appareil est affi-

ché. Avec "OK" on établit un lien avec l'appareil et on installe l'appareil dans la base de données 

PC. 

3. Adapter les réglages d'appareil et sélectionner "Terminé -> Transmission de la configuration à 

l'appareil". Les nouveaux paramètres de configuration sont automatiquement transmis à 

l'appareil. 

4. Ensuite il faut mémoriser les réglages d'appareil dans la base de données. Sélectionner "Ter-

miné -> Mémoriser la configuration dans la base de données de l'appareil".

5.4.4 Configuration via carte SD 

Mémoriser les réglages de l'appareil stockés dans le PC sur la carte SD par le biais du logiciel PC 

fourni. Ce fichier de configuration peut, si libéré sous "Options - Carte SD - Enreg. la config." être 

repris dans l'appareil.

! Remarque ! 

Pour pouvoir utiliser cette fonction il faut que l'appareil figure déjà dans la base de données PC ou 

bien il convient de l'installer. En outre il faut qu'un emplacement de carte SD existe sur le PC.

" Attention ! 

Ne jamais déposer la carte SD avant d'avoir affiché au préalable la fonction "Options -> Carte SD 

-> Retirer en toute sécurité" sous peine d'avoir une perte de données. 

Procédure de configuration par carte SD :

1. Copier la configuration sur la carte SD :

- Insérer une carte SD formatée dans l'appareil.

- Dans le menu sélectionner "Carte SD -> Enreg. la config.".

- Dans le menu sélectionner "Carte SD -> Retirer en toute sécurité".

- Retirer la carte SD de son emplacement sur l'appareil et la mettre en place dans l'emplace-

ment du PC.

2. Démarrer le logiciel PC et installer le nouvel appareil dans la base de données PC : 

- Sélectionner "Appareil -> Afficher/modifier la configuration de l'appareil/Nouvel appareil"

- Sélectionner "Appareil - Insérer nouvel appareil"

- Entrer la description d'appareil. Pour la transmission des réglages d'appareil, sélectionner 

"Fichier paramètres d'un support de données (par ex. disquette, ATA-Flash, CF, SD)". Confir-

mer avec "Poursuivre". Sélectionner le fichier de paramètres correspondant (*.rpd) sur la carte 

SD. Confirmer avec "Poursuivre". Un résumé des indications relatives au nouvel appareil est 

affiché. Avec "OK" on installe le nouvel appareil dans la base de données PC. 

3. Adapter la configuration dans le logiciel PC et la valider dans la base de données correspon-

dante :

- Adapter les réglages d'appareil.

- Sélectionner "Terminé/Mémoriser les réglages dans la base de données". Les nouveaux para-

mètres de configuration sont mémorisés dans la base de données PC. Transférer le nouveau 

fichier CONFIGURATION sur la carte SD dans votre PC : Sélectionner "Terminé/ Créer un 

support de données Configuration (disquette / ATA-Flash / CF / SD)" et choisir le lecteur cor-

respondant.
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- Retirer la carte SD de son emplacement sur le PC et la mettre en place dans l'appareil.

4. Lire la nouvelle configuration directement à l'appareil :

- Dans le menu sélectionner "Carte SD -> Enreg. la config.". Pour déposer la carte SD, sélec-

tionner dans le menu Options "Carte SD -> Retirer en toute sécurité". Répéter cette procédure 

pour paramétrer d'autres appareils avec cette configuration. 

" Attention ! 

Si cette carte SD de configuration n'est pas enlevée, la mémorisation des données de mesure com-

mence après env. 5 minutes. Les données de configuration sont maintenues. Remplacer la carte SD 

lorsque les données de mesure ne doivent pas être mémorisées sur cette carte.

" Attention ! 

Un fonctionnement sûr est seulement assuré avec une carte SD originale du fabricant (voir "Acces-

soires" chapitre 8).

5.4.5 Configuration via clé USB

Mémoriser les réglages de l'appareil stockés dans le PC sur une clé USB par le biais du logiciel PC 

fourni. Ce fichier de configuration peut, si libéré sous "Options - Clé USB - Enreg. la config." être 

repris dans l'appareil.

! Remarque ! 

Pour pouvoir utiliser cette fonction il faut que l'appareil figure déjà dans la base de données PC ou 

bien il convient de l'installer. De plus, il faut qu'une prise USB libre soit disponible sur le PC. 

" Attention ! 

Ne jamais déposer la clé USB avant d'avoir affiché au préalable la fonction "Options -> Clé USB -> 

Retirer en toute sécurité" sous peine d'avoir une perte de données. 

Procédure de configuration par clé USB : 

1. Copier la configuration sur clé USB :

- Embrocher la clé USB dans la prise USB-A en face avant ou à l'arrière de l'appareil. 

- Dans le menu Options sélectionner "Clé USB -> Enreg. la config.".

- Dans le menu Options sélectionner "Clé USB -> Retirer en toute sécurité".

- Enlever la clé USB de l'appareil et l'embrocher dans la prise USB sur le PC. 

2. Démarrer le logiciel PC et installer le nouvel appareil dans la base de données PC : 

- Sélectionner "Appareil -> Afficher/modifier la configuration de l'appareil/Nouvel appareil"

- Sélectionner "Appareil - Insérer nouvel appareil"

- Entrer la description d'appareil. Pour la transmission des réglages d'appareil, sélectionner 

"Fichier paramètres d'un support de données (par ex. disquette, ATA-Flash, CF, SD)". Confir-

mer avec "Poursuivre". Sélectionner le fichier de paramètres correspondant (*.rpd) sur la clé 

USB. Confirmer avec "Poursuivre". Un résumé des indications relatives au nouvel appareil est 

affiché. Avec "OK" on installe le nouvel appareil dans la base de données PC. 

3. Adapter la configuration dans le logiciel PC et le valider dans la base de données correspon-

dante :

- Adapter les réglages d'appareil.

- Sélectionner "Terminé/Mémoriser les réglages dans la base de données". Les nouveaux para-

mètres de configuration sont mémorisés dans la base de données PC. Transférer le nouveau 

fichier de configuration sur la clé USB dans votre PC : Sélectionner "Terminé/ Créer un sup-

port de données Configuration (disquette / ATA-Flash / CF / SD)" et choisir le lecteur corres-

pondant.

- Enlever la clé USB de l'appareil et l'embrocher dans la prise USB-A sur le PC. 

4. Lire la nouvelle configuration directement à l'appareil :

- Dans le menu Options sélectionner "Clé USB -> Enreg. la config.". Pour enlever la clé USB, 

sélectionner dans le menu Options "Clé USB -> Retirer en toute sécurité". Répéter cette pro-

cédure pour paramétrer d'autres appareils avec cette configuration. 
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5.4.6 Configuration directement sur l'appareil (via touches/navigateur)

Fonctions des touches pour la configuration

La fonction des touches est décrite à l'écran dans les cases directement au-dessus des touches cor-

respondantes. Des cases vides signifient que les touches correspondantes sont momentanément sans 

fonction.

• Appuyer sur le navigateur ; le menu principal est affiché

• Avec le navigateur sélectionner le menu "Configuration"

• Valider l'entrée en appuyant à nouveau sur le navigateur. 

• Avec la touche softkey "Aide" on peut afficher une aide relative à l'entrée sélectionnée. 

• La touche softkey "Interrompre" ou "Retour" entraine une interruption de l'entrée ou un retour à 

l'écran précédent. 

! Remarque ! 

• Chaque paramètre est modifié par le biais d'une fenêtre de dialogue.

• Les réglages modifiés deviennent seulement actifs lorsqu'après activation de "Retour" vous reve-

nez au mode normal (validation de la configuration avec "Oui"). Jusqu'à ce moment l'appareil 

fonctionne avec les données précédentes.

Procédure relative à la configuration d'appareil :

! Remarque ! 

Après la mise en service (configuration d'appareil), la carte SD et la mémoire interne devraient être 

effacées pour pouvoir supprimer les données de configuration temporaires !

Effacer la carte SD : Options -> Carte SD -> Effacer

Effacer la mémoire interne : Menu principal -> Diagnostic / Simulation -> Effacer mémoire 

interne

Démarrage



Réglages système (langue, date/heure, communication, sécurité etc.) 



Entrée (entrées universelle : type de signal, gamme d'entrée etc.) 



Entrée (entrées digitales : fonction, désignation etc.)



Entrée voies mathématiques (Option)



Sorties (p. ex. relais ou sorties analogiques/impulsions - si nécessaire)



Réglages d'applications (Seuils et relais alarme et relais - si nécessaire)



Réglages d'applications (Groupement de signaux, textes, Touches program.)



Fin
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Presentazione in breve

Per una messa in servizio semplice e rapida:

Istruzioni di funzionamento integrate nello strumento

Il semplice sistema di controllo dello strumento consente di eseguire la messa in servizio per diversi 

tipi di applicazione, senza richiedere la consultazione del materiale cartaceo. Lo strumento 

visualizza le istruzioni sullo schermo, premendo semplicemente un tasto. Tuttavia, in dotazione allo 

strumento vengono fornite anche un manuale di istruzioni, a integrazione delle istruzioni di 

funzionamento caricate nello strumento stesso. Tutto ciò che non viene descritto direttamente a 

video sullo strumento mediante testo o menu è riportato nel presente manuale.

Fig. 1: Softkey a funzione variabile (es. per richiamare la Guida interna in modalità Setup)

Questo documento comprende le Istruzioni di funzionamento brevi. Per informazioni più 

dettagliate consultare le Istruzioni di funzionamento e la documentazione integrativa pre-

sente sul CD ROM fornito.

Le Istruzioni di funzionamento brevi non sostituiscono le Istruzioni di funzionamento comprese 

nella fornitura.

La documentazione completa del dispositivo comprende:

• Queste Istruzioni di funzionamento brevi

• CD-ROM con file PDF dei seguenti documenti:

– Istruzioni di funzionamento

– Fondamenti dei principi di misura 

– Approvazione e certificati di sicurezza

1. Osservare le Istruzioni di sicurezza Pagina 59



2. Installare lo strumento Pagina 60



3. Cablare lo strumento Pagina 62



4. Installare il software operativo per PC Pagina 69



5. Collegare lo strumento al PC Pagina 69



6. Configurare lo strumento (tramite PC) Pagina 70



7. Trasferire i dati di configurazione allo strumento Pagina 70
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1 Istruzioni di sicurezza

1.1 Uso previsto

Questo strumento è progettato per l'acquisizione elettronica, la visualizzazione, la registrazione, 

l'analisi, la trasmissione remota e l'archiviazione di segnali d'ingresso analogici e digitali in area 

sicura.

• Questo strumento è stato progettato per montaggio a fronte quadro o in armadio e può essere 

impiegato solo se installato correttamente.

• Il costruttore non è responsabile per danni causati dall’uso errato o improprio dello strumento. Lo 

strumento può risultare pericoloso se usato in modo improprio o in modo diverso da quanto 

descritto nel presente manuale.

1.2  Installazione, messa in servizio e funzionamento

• Lo strumento deve essere installato, collegato, messo in servizio e sottoposto a manutenzione solo 

da personale tecnico competente e autorizzato (es. elettricisti qualificati), in conformità con le 

istruzioni riportate nel presente manuale, le norme applicabili, le regolamentazioni legali e i 

certificati (a seconda dell'applicazione).

• Il personale deve avere letto e compreso questo manuale e seguire le istruzioni in esso contenute.

• Lo strumento può essere sottoposto a modifica o riparazione solo se tali operazioni sono 

espressamente consentite nelle Istruzioni di funzionamento.

• Gli strumenti guasti che potrebbero rappresentare un pericolo non devono essere messi in 

servizio, e devono essere segnalati come difettosi tramite apposizione di un'etichetta.

• In primo luogo, attenersi alle norme locali in materia di smontaggio e riparazione delle 

apparecchiature elettriche.

1.3 Sicurezza operativa

• Lo strumento è stato costruito e testato secondo la tecnologia più all'avanguardia e ha lasciato la 

fabbrica in perfette condizioni per quanto riguarda la sicurezza. Sono state tenute in 

considerazione le norme applicabili e gli standard europei.

• Osservare i dati tecnici riportati sulla targhetta! La targhetta si trova sul lato sinistro della custodia.

Compatibilità elettromagnetica

Il sistema di misura soddisfa i requisiti generali di sicurezza della normativa IEC 61010 e i requisiti 

di compatibilità elettromagnetica della normativa IEC 61326.

Versione desktop

# Attenzione! 

• Il connettore di alimentazione principale deve essere inserito esclusivamente in una presa con 

contatto di terra.

• Non escludere la funzione di protezione utilizzando un cavo di estensione privo di messa a terra.

• Uscite a relè: U (max) = 30 V rms (c.a.) / 60 V (c.c.)

1.4 Note sulle convenzioni e sui simboli di sicurezza 

Si raccomanda di osservare scrupolosamente le istruzioni di sicurezza riportate nelle presenti 

Istruzioni di funzionamento, indicate dai seguenti simboli:

# Attenzione! 

Questo simbolo indica attività o procedure che, se non eseguite correttamente, possono provocare 

lesioni alle persone, rischi per la sicurezza o danni irreparabili allo strumento.

" Pericolo! 

Questo simbolo indica attività o procedure che, se non eseguite correttamente, possono causare il 

funzionamento improprio o danni irreparabili allo strumento.

! Nota! 

Questo simbolo indica attività o procedure che, se non eseguite correttamente, possono avere un 

effetto indiretto sul funzionamento o determinare una risposta inattesa dello strumento.
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ESD (Scariche elettrostatiche)

Proteggere i morsetti dalle scariche elettrostatiche. Il mancato rispetto di queste precauzioni può 

causare danni irreparabili ai componenti elettronici.

2 Identificazione

2.1 Fornitura

• Unità (con morsetti, in base all'ordine)

• 2 fermagli di fissaggio

• Cavo di interfaccia USB, lunghezza 1,5 m

• Scheda SD (Secure Digital) opzionale (scheda fornita a parte, non inserita nello strumento)

• Software operativo e di configurazione per PC su CD-ROM

• Nota di consegna

• Istruzioni di funzionamento multilingue brevi, versione cartacea

• Istruzioni di funzionamento multilingue su CD-ROM

In caso di elementi mancanti, contattare il fornitore.

3 Installazione

3.1 Condizioni per l’installazione

Campo di temperatura di esercizio:

-10 ... 50 °C, umidità relativa max. 75% senza condensa.

" Pericolo! 

• Per evitare l’accumulo di calore, assicurare un raffreddamento adeguato dello strumento.

• Mantenere lo strumento a distanze adeguate da forti campi magnetici (v. Capitolo 10 "Dati 

tecnici", immunità alle interferenze)

• Condizioni ambiente consentite - parte anteriore: in conformità con il grado di protezione max. 

IP65 (con frontalino aperto)

3.2 Istruzioni di installazione

3.2.1 Utensili di montaggio

Per il montaggio a fronte quadro è necessario solo un cacciavite.
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3.2.2 Montaggio a fronte quadro, dimensioni di installazione

Fig. 2: Montaggio a fronte quadro, dimensioni di installazione. Tutte le dimensioni sono in mm.

• Profondità di installazione senza copri-morsettiera: ca. 158 mm (inclusi morsetti e fermagli di 

fissaggio)

• Profondità di installazione con copri-morsettiera: ca. 197 mm

• Dima di foratura: 138+1 x 138+1 mm

• Spessore del pannello: 2 ... 40 mm

• Angolo di visualizzazione max.: 50° dall'asse centrale del display, in tutte le direzioni

• Fissaggio secondo DIN 43 834

1. Spingere l'unità attraverso la parte anteriore della sfinestratura del pannello. Per evitare 

accumuli di calore, si raccomanda di mantenere una distanza > 15 mm dalle pareti e da altri 

strumenti.

2. Tenere lo strumento in orizzontale, quindi inserire le due viti di pressione nelle aperture 

opposte (o sui lati sinistra a destra della custodia, oppure sulla parte superiore e inferiore).

3. Stringere le viti a pressione facendo fare lo stesso numero di giri, in modo che lo strumento 

risulti ben fissato sul pannello di controllo (cacciavite dinamometrico: 100 Ncm).

! Nota! 

• Mantenere una distanza minima di 7 mm fra gli strumenti, se questi ultimi devono essere allineati 

in direzione Y (verticalmente uno sopra l'altro).
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• Gli strumenti possono essere disposti orizzontalmente l'uno accanto all'altro in direzione X senza 

osservare nessuna distanza.

• Se si utilizzano più strumenti, la griglia delle sfinestrature nel quadro di controllo deve avere 

dimensioni minime di 196,2 mm in senso orizzontale e 156,2 mm in verticale (tolleranza non 

considerata).

4 Cablaggio

4.1 Guida rapida al cablaggio

# Attenzione! 

Si noti che tutti i collegamenti elettrici devono essere eseguiti con lo strumento fuori tensione.

" Pericolo! 

• La messa a terra deve essere eseguita prima di tutte le altre connessioni. Qualsiasi interruzione 

della linea di terra può essere fonte di pericolo.

• Prima della messa in servizio, confrontare la tensione di alimentazione con quanto specificato 

sulla targhetta (lato sinistro della custodia).

• Non è ammessa la connessione mista tra la bassissima tensione di sicurezza e tensioni di contatto 

pericolose applicate a relè.

• Se lo strumento viene installato in un fabbricato, montare un interruttore di protezione o un 

sezionatore idonei. Tale interruttore deve essere montato in prossimità dello strumento (in 

posizione facilmente accessibile) ed essere contrassegnato come separatore.

• Per il cavo di alimentazione è necessario predisporre un dispositivo di protezione da sovracorrente 

(corrente nominale 10 A).

! Nota! 

Fare riferimento anche ai numeri dei morsetti riportati sul retro dello strumento.

4.1.1 Assegnazione dei colori ai canali

In Setup "Applicazione -> Gruppi di segnali" è possibile definire i colori di identificazione dei canali. 

È possibile scegliere fra 8 colori predefiniti per gruppo, che possono essere assegnati a piacere ai 

canali desiderati.
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4.1.2 Schema del circuito

Fig. 3: Schema del circuito

! Nota! 

Lo slot 5 può essere utilizzato per inserire vari tipi di schede (ingressi/uscite analogici o digitali), a 

seconda dei componenti ordinati. Quando si esegue un collegamento, si prega di consultare lo 

schema dei morsetti corrispondente alle opzioni prescelte.

Ethernet USB RS 232 / RS 485 Bus Interface
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4.1.3 Uso dell'uscita in tensione ausiliaria per alimentare il 

trasmettitore per sensori bifilari

Fig. 4: Connessione dell'uscita in tensione ausiliaria, se impiegata per l'alimentazione di un trasmettitore per sensori 

bifilari nel campo di misura della corrente

_

+-

Y

+-

Y

+

+

_

2
4

V
O

u
t:

m
a

x
.

3
0

0
m

A

Per la connesione dei canali 3-16,
vedi i terminali di connessione canali 1-2

Sensore 1
ad es. TR10 (E+H)

Sensore 2

esposizione esterna
(facoltativa) ad es.
RIA261 (E+H)



Cablaggio

65

4.1.4 Uso dell'uscita in tensione ausiliaria per alimentare il 

trasmettitore per sensori quadrifilari

Fig. 5: Connessione dell'uscita in tensione ausiliaria, se impiegata per l'alimentazione di un trasmettitore per sensori 

a 4 fili nel campo di misura della corrente
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4.2 Assegnazione dei morsetti

" Pericolo! 

Se si verifica un transiente ad alta energia quando si usano dei cavi di trasmissione del segnale 

lunghi, si consiglia di utilizzare una protezione alle sovratensioni appropriata (per es. E+H 

HAW560/562).

Si raccomanda di utilizzare linee di segnale schermate per le interfacce seriali.

4.2.1 Specifiche del cavo, morsetti a molla

Tutte le connessioni sul retro dell'unità vengono eseguite per mezzo di morsettiere con morsetti a 

vite o molla con protezione contro l'inversione di polarità. In questo modo la connessione risulta 

molto semplice e rapida. Per le connessioni con i morsetti a molla è necessario un cacciavite a taglio 

(dimensione 0).

Per le connessioni si prega di tenere a mente quanto segue:

• Sezione fili, I/O digitale, RS485 e ingressi analogici: max. 1,5 mm2 (14 AWG) (morsetti a molla)

• Sezione fili, alimentazione: max. 2,5 mm2 (13 AWG) (morsetti a vite)

• Sezione fili, relè: max. 2,5 mm2 (13 AWG) (morsetti a molla)

• Lunghezza spelature: 10 mm, 6 mm per morsetto di alimentazione

! Nota! 

Non è necessario utilizzare delle guaine per collegare fili flessibili ai morsetti a molla.

4.2.2 Connessione delle interfacce

Connessione Ethernet, RS232/RS485 e USB

Informazioni sulla connessione delle interfacce disponibili nelle Istruzioni di funzionamento su 

CD-ROM, capitolo 4.2.

4.3 Grado di protezione

La parte anteriore dello strumento soddisfa tutti i requisiti previsti per il grado di protezione IP65.
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5 Messa in servizio e funzionamento

5.1 Display ed elementi operativi

Fig. 6: Display dello strumento / unità di controllo
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2
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Elemento di 

comando (n.)

Funzione

(Modalità Display = visualizzazione del valore misurato)

(Modalità Setup = configurazione tramite il menu Setup)

1  Manopola jog/shuttle "Navigator" di comando con funzione di pressione aggiuntiva.

In modalità Display: ruotare la manopola per passare ai vari gruppi di segnali. Premere la manopola 

per visualizzare il menu principale.

In modalità Setup o in un menu di selezione: ruotare la manopola in senso antiorario per spostare la 

barra o il cursore verso l'alto, in senso antiorario per modificare l'impostazione del parametro. 

Ruotando in senso orario è possibile spostare la barra o il cursore verso il basso, in senso orario si 

modifica l'impostazione del parametro. Pressione = selezione della funzione evidenziate, avvio della 

modifica di un parametro (ENTER/Invio).

2 Funzioni dei LED (secondo NAMUR NE44:)

• LED verde (in alto) acceso: alimentazione OK, strumento in funzione in modo normale

• LED rosso (in basso) lampeggiante: necessità di un intervento di manutenzione per problema 

esterno allo strumento (es. interruzione linea, ecc.) o presenza di un messaggio/avviso in attesa di 

tacitazione, taratura in corso.

3  Softkey a funzione variabile 1 - 4 (da sinistra a destra)

4 Indicazione della funzione del softkey

5 In modalità Display: nome del gruppo corrente, tipo di analisi

In modalità Setup: nome dell'elemento operativo corrente (titolo della finestra di dialogo)
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5.2 Configurazione della lingua dell'interfaccia

Per impostazione predefinita, le diciture dell'interfaccia vengono visualizzate in inglese. Tuttavia, è 

possibile selezionare un'altra lingua dal menu principale.

Premere il Navigator  -> Lingua

Fig. 7: Modifica della lingua dell'interfaccia operativa dal menu principale

6 In modalità Display: visualizzazione della data e dell'ora attuali

In modalità Setup: --

7 In modalità Display: ID utente (se la funzione è stata attivata)

In modalità Setup: --

8 In modalità Display: visualizzazione alternata indicante la percentuale della scheda SD o della 

chiavetta USB già occupata da dati.

Sullo strumento vengono visualizzati dei simboli di stato relativi alle seguenti funzioni (la 

visualizzazione si alterna alle informazioni relative alla memoria): modalità simulazione, archiviazione 

dei dati attiva, blocco operativo, funzione batch attiva 1)

In modalità Setup: viene visualizzato il codice operativo di "accesso diretto" corrente

9 In modalità Display: schermata di visualizzazione del valore misurato

Visualizzazione dei valori attualmente misurati e dello stato in una condizione di guasto/allarme, a 

seconda della visualizzazione del segnale selezionata. Nel caso dei contatori, viene visualizzato un 

simbolo indicante il tipo di contatore selezionato 1).

! Nota! 

Se è stato raggiunto un valore di soglia in corrispondenza di un punto di misura, l'identificativo del 

canale corrispondente viene evidenziato in rosso (per facilitare l'individuazione dei valori di soglia). Se 

lo strumento è in funzione, l'acquisizione dei valori misurati prosegue senza interruzioni.

10 In modalità Display: visualizzazione alternata dello stato (es. intervallo di zoom impostato) degli 

ingressi analogici e digitali con il colore del canale corrispondente.

In modalità Setup: possono apparire informazioni diverse a seconda del tipo di visualizzazione 

prescelta.

a Slot per scheda SD

" Pericolo! 

 Si raccomanda di non rimuovere la scheda SD mentre è acceso il LED (d) giallo, altrimenti si rischia 

di perdere i dati.

b Porta USB B tipo "funzione" es. per computer portatile

c Porta USB A tipo "host" es. per chiavetta USB 

d LED su slot SD

Il LED giallo si accende durante la lettura o scrittura su scheda SD.

" Pericolo! 

Si raccomanda di non rimuovere la scheda SD mentre è acceso il LED giallo, altrimenti si rischia di 

perdere i dati.

1) Riepilogo dei simboli, v. Istruzioni di funzionamento sul CD-ROM.

Elemento di 

comando (n.)

Funzione

(Modalità Display = visualizzazione del valore misurato)

(Modalità Setup = configurazione tramite il menu Setup)
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5.3 Messa in servizio

Quando si applica la tensione di alimentazione, il display si accende, dopodiché lo strumento è 

pronto per l'uso.

• Invece, se si sta eseguendo la messa in servizio di uno strumento già configurato, la misura viene 

avviata immediatamente in base alle impostazioni. Sul display vengono visualizzati i valori del 

gruppo attualmente configurato.

• Per la prima messa in servizio dell'unità, impostare la configurazione come descritto nelle Istru-

zioni di funzionamento su CD-ROM, capitolo 6.3.

5.4 Comunicazione; Installazione del software per PC

! Nota! 

Per stabilire una connessione fra lo strumento e il PC, è necessario installare il software per PC 

versione V1.25.0.0 (o successiva) fornito in dotazione. Per sicurezza, si consiglia di installare il 

pacchetto software per PC corrente (CD-ROM fornito in dotazione).

5.4.1 Installazione del software per PC fornito in dotazione 

! Nota! 

Per poter utilizzare il software per PC fornito in dotazione deve essere installato il carattere "Arial 

Unicode MS™" sul PC in uso, altrimenti alcuni caratteri potrebbero non essere visualizzati 

correttamente o non essere visualizzati del tutto. Verificare che il font sia installato sul PC 

selezionando "Pannello di controllo - Caratteri". Se questo font non è installato, consultare la guida 

di Microsoft Office® o Microsoft Windows®.

! Nota! 

Per poter eseguire l'installazione del software è necessario disporre di diritti di amministratore.

1. Installare sul computer il software per PC fornito. Se richiesto, dopo l’installazione è possibile 

stampare le Istruzioni di funzionamento contenute nel programma.

2. Quando il software per PC sarà stato installato, sarà possibile avviare il software selezionando 

"Start -> Tutti i programmi".

5.4.2  Comunicazione tramite USB / Installazione del driver USB

In seguito all'installazione del software per PC fornito in dotazione, sarà possibile collegare lo 

strumento al PC utilizzando un cavo USB. Il sistema operativo rileva automaticamente il nuovo 

strumento USB.

! Nota! 

Attenersi alla seguente procedura per installare il driver USB (la procedura varia a seconda del 

sistema operativo):

1. Viene visualizzato il messaggio di Windows "Consentire la connessione a Windows Update per 

la ricerca di software?". Fare clic su "No, non ora" e quindi su "Avanti".

2. Viene visualizzata la finestra "Scegliere un'opzione:". Selezionare "Installa il software 

automaticamente (scelta consigliata)", quindi fare clic su "Avanti".

Sarà quindi possibile avviare il software per PC fornito in dotazione per stabilire una connessione fra 

lo strumento e il PC.

" Pericolo! 

Attendere almeno 15 secondi prima di eseguire la connessione e la disconnessione dello strumento 

dalla porta USB del PC.
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5.4.3 Procedura di configurazione tramite l'interfaccia e il software 

per PC fornito in dotazione:

! Nota! 

Per poter usare questa funzione, lo strumento deve essere già stato creato nel database del PC, 

altrimenti sarà necessario crearlo prima di procedere.

1. Connettere l'interfaccia dello strumento (RS232 / RS485, USB o Ethernet) al PC.

2. Avviare il software per PC e creare un nuovo strumento nel database del PC:

- Selezionare "Unità -> Visualizza/modifica setup unità - Aggiungi nuova unità"

- Selezionare "Unità -> Aggiungi nuova unità"

- Inserire l'identificativo dello strumento. Per trasmettere la configurazione dello strumento, 

selezionare l'interfaccia corrispondente dello strumento. Confermare selezionando "Avanti". 

Selezionare i parametri dell'interfaccia (devono corrispondere ai parametri di comunicazione 

impostati sullo strumento). Confermare selezionando "Avanti". Viene quindi visualizzato un 

riepilogo delle informazioni relative al nuovo strumento. Facendo clic su "OK", viene stabilita 

una connessione con lo strumento, e il nuovo strumento viene creato nel database del PC.

3. Regolare le impostazioni dello strumento e selezionare "Operazione completata -> Invia setup 

all'unità". I nuovi parametri di configurazione vengono trasferiti automaticamente allo 

strumento.

4. Per completare l'operazione, è necessario salvare le impostazioni nel database dello strumento. 

Selezionare "Operazione completata -> Salva configurazione in database unità".

5.4.4 Configurazione tramite scheda SD

Questa procedura consente di salvare su una scheda SD le impostazioni dello strumento 

memorizzate su PC, utilizzando il software per PC fornito in dotazione. Questo file di 

configurazione potrà quindi essere importato nello strumento.

! Nota! 

Per poter usare questa funzione, lo strumento deve essere già stato creato nel database del PC, 

altrimenti sarà necessario crearlo prima di procedere. Inoltre, deve essere presente una scheda SD 

nell'apposito slot del PC.

" Pericolo! 

Prima di rimuovere la scheda SD dallo strumento è necessario selezionare preventivamente la 

funzione "Altre funzioni -> Scheda SD -> Rimozione sicura", altrimenti si rischia di perdere i dati.

Procedura di configurazione tramite scheda SD:

1. Copiare la configurazione sulla scheda SD:

- Inserire una scheda SD formattata nello strumento.

- Dal menu Altre funzioni, selezionare "Scheda SD -> Salva configurazione".

- Dal menu Altre funzioni, selezionare "Scheda SD -> Rimozione sicura".

- Rimuovere la scheda SD dallo strumento e inserirla nell'apposito slot SD del PC.

2. Avviare il software per PC e creare un nuovo strumento nel database del PC:

- Selezionare "Unità -> Visualizza/modifica setup unità - Aggiungi nuova unità"

- Selezionare "Unità -> Aggiungi nuova unità"

- Inserire l'identificativo dello strumento. Selezionare "File di configurazione da sorgente dati 

(es. floppy, ATA Flash, CF, SD)" per trasmettere la configurazione dello strumento. Confermare 

selezionando "Avanti". Selezionare il file di configurazione dello strumento (*.rpd) sulla scheda 

SD. Confermare selezionando "Avanti". Viene quindi visualizzato un riepilogo delle 

informazioni relative al nuovo strumento. Facendo clic su "OK", il nuovo strumento viene 

creato nel database del PC.

3. Regolare la configurazione del programma per PC e salvarla nel database associato:

- Regolare le impostazioni dello strumento.

- Selezionare "Operazione completata -> Salva configurazione in database unità". I nuovi 

parametri di configurazione vengono salvati nel database del PC. Trasferire il nuovo file di 

SETUP alla scheda SD inserita nello slot del PC: selezionare "Operazione completata -> Crea 

supporto dati configurazione (floppy/ATA flash/CF/SD)" e selezionare l'unità corrispondente.
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- Rimuovere la scheda SD dallo slot del PC e inserirla nello strumento.

4. Leggere la nuova configurazione direttamente dallo strumento:

- Dal menu Altre funzioni, selezionare "Scheda SD -> Carica configurazione". Per rimuovere 

la scheda SD, selezionare "Scheda SD -> Rimozione sicura" nel menu Altre funzioni. Ripetere 

la procedura per configurare altri strumenti caricando la stessa configurazione.

" Pericolo! 

Se la scheda SD non viene rimossa, dopo ca. 5 minuti ha inizio la memorizzazione dei nuovi dati di 

misura sulla scheda. I dati di configurazione vengono comunque mantenuti. Se si vuole evitare che 

i dati di misura vengano salvati sulla scheda SD, estrarla e sostituirla con un'altra.

" Pericolo! 

È possibile garantire un funzionamento corretto e sicuro dello strumento solo se si utilizzano schede 

SD approvate dal produttore (v. "Accessori", Capitolo 8).

5.4.5 Configurazione tramite chiavetta USB

Questa procedura consente di salvare su una chiavetta USB le impostazioni dello strumento 

memorizzate su PC, utilizzando il software per PC fornito in dotazione. Questo file di 

configurazione potrà quindi essere importato nello strumento.

! Nota! 

Per poter usare questa funzione, lo strumento deve essere già stato creato nel database del PC, 

altrimenti sarà necessario crearlo prima di procedere. Inoltre, sul PC deve essere presente una porta 

USB libera.

" Pericolo! 

Prima di rimuovere la chiavetta USB dallo strumento è necessario selezionare preventivamente la 

funzione "Altre funzioni -> Chiavetta USB -> Rimozione sicura", altrimenti si rischia di perdere i 

dati.

Procedura di configurazione tramite chiavetta USB:

1. Copiare la configurazione sulla chiavetta USB:

Inserire la chiavetta USB nella porta USB A, posta sulla parte anteriore o posteriore dello 

strumento.

- Dal menu Altre funzioni, selezionare "Chiavetta USB -> Salva configurazione".

- Dal menu Altre funzioni, selezionare "Chiavetta USB -> Rimozione sicura".

- Rimuovere la chiavetta USB dallo strumento e inserirla in una porta USB del PC.

2. Avviare il software per PC e creare un nuovo strumento nel database del PC:

- Selezionare "Unità -> Visualizza/modifica setup unità - Aggiungi nuova unità"

- Selezionare "Unità -> Aggiungi nuova unità"

- Inserire l'identificativo dello strumento. Selezionare "File di configurazione da sorgente dati 

(es. floppy, ATA Flash, CF, SD)" per trasmettere la configurazione dello strumento. Confermare 

selezionando "Avanti". Selezionare il file di configurazione dello strumento (*.rpd) sulla 

chiavetta USB. Confermare selezionando "Avanti". Viene quindi visualizzato un riepilogo delle 

informazioni relative al nuovo strumento. Facendo clic su "OK", il nuovo strumento viene 

creato nel database del PC.

3. Regolare la configurazione del programma per PC e salvarla nel database associato:

- Regolare le impostazioni dello strumento.

- Selezionare "Operazione completata -> Salva configurazione in database unità". I nuovi 

parametri di configurazione vengono salvati nel database del PC. Trasferire il nuovo file di 

SETUP alla chiavetta USB inserita nello slot del PC: selezionare "Operazione completata -> 

Crea supporto dati configurazione (floppy/ATA flash/CF/SD)" e selezionare l'unità 

corrispondente.

- Rimuovere la chiavetta USB dal PC e inserirla nella porta USB A dello strumento.

4. Leggere la nuova configurazione direttamente dallo strumento:

- Dal menu Altre funzioni, selezionare "Chiavetta USB -> Carica configurazione". Per 

rimuovere la chiavetta USB, selezionare "Chiavetta USB -> Rimozione sicura" nel menu Altre 

funzioni. Ripetere la procedura per configurare altri strumenti caricando la stessa 

configurazione.
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5.4.6 Configurazione diretta sullo strumento (tramite tasti/navigator) 

Funzioni dei tasti durante la procedura di configurazione

La funzione della tastiera operatore è descritta nei campi direttamente sopra i tasti corrispondenti a 

video. Se sono presenti dei campi vuoti, significa che i tasti corrispondenti non hanno alcuna 

funzione.

• Premere il navigator, compare il menu principale

• Utilizzando il navigator, selezionare il menu "Setup"

• Premere nuovamente il navigator per confermare

• Il softkey "Guida" consente di visualizzare il testo della Guida relativo all'opzione selezionata.

•  I softkey "Annulla" o "Indietro" consentono di annullare i dati inseriti o di ritornare alla schermata 

precedente.

! Nota! 

• La modifica dei singoli parametri avviene per mezzo di una finestra di dialogo.

• Affinché le modifiche diventino operative, è necessario ritornare alla modalità operativa normale 

premendo ripetutamente "Indietro" (per confermare la configurazione è necessario selezionare 

"sì"). Fino a quel momento, lo strumento continuerà a funzionare in base alle impostazioni 

precedenti.

Procedura di configurazione (setup) dello strumento:

! Nota! 

In seguito alla messa in servizio (configurazione dello strumento), è necessario formattare la scheda 

SD e la memoria interna per eliminare i dati di configurazione temporanei.

Cancellazione dei dati della scheda SD: Altre funzioni -> Scheda SD -> Elimina

Cancellazione dei dati della memoria interna: Menu principale -> Diagnostica / Simulazione 

-> Cancella memoria interna

Avvio



Impostazioni di sistema (lingua, data/ora, comunicazione, sicurezza, ecc.)



Ingressi (ingressi universali: tipo di segnale, campo di ingresso, ecc.)



Ingressi digitali (ingressi digitali: funzione, designazione, ecc.)



Ingressi per canali matematici (opzionale)



Uscite (relè o uscite analogiche/impulsi - se necessari)



Impostazioni dell'applicazione (valori di soglia e relè di allarme - se necessari)



Impostazioni dell'applicazione (raggruppamento segnali, testo, softkey)



Fine
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